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Introduction
Microsoft 365 Excel is now the dominant way to purchase Excel. Microsoft did a good job of 
offering more value to Microsoft 365. They are reluctantly releasing a perpetual edition of Excel 
2021, but they say that it is only for specific scenarios where people do not have access to the 
Internet.

Those people without the Internet will be paying quite a premium for an obsolete version 
of Excel without any of the connected features. The price for the perpetual version of Office 
increased by 10% to $440 per device for Office 2021. In contrast, you can license Microsoft 365 
for five devices for $99 per year.

The Excel team has been responsive to items requested through the Excel.UserVoice.com web-
site, and many small features and improvements have happened since the last edition of this 
book.

	● You can now unhide multiple worksheets at once.

	● The Conditional Formatting Rules Manager dialog box is now resizable.

	● Scroll horizontally with Ctrl+Shift+Wheel.

	● Increased the 218-character file limit.

	● When copying a worksheet, added a Yes To All option for dealing with Name conflicts.

	● The Excel team added a new padlock icon to the sheet tabs to indicate if a sheet was 
protected. When this was met with a chorus of complaints, the lock icon was promptly 
removed.

	● The SINGLE function, used to trigger implicit intersection, was replaced with the  
@ operator.

	● You can insert new icons and cut-out people in Excel.

	● Images can easily be set to semi-transparent so you can see the data behind an image.

	● Right-click any object and choose Save As Image to create an image of a chart, SmartArt, 
shape, and so on.

	● You can “write” data using the Action Pen.

	● Multiple task panes now collapse into a single strip at the right side of Excel.

	● There is a new Accessibility Checker tab in the ribbon.

	● Several performance improvements make Excel faster.

www.itbook.store

http://Excel.UserVoice.com
https://itbook.store


xxvi	 Introduction

There are also several large changes made to Excel:

	● Co-authoring continues to improve. You can now @Mention people in comments and 
create tasks. Excel will allow each person to have their own version of the data with filters 
and sorting that only they can see. The new Show Changes feature lets you see changes 
made to your worksheet in the last 60 days. Read more in Chapter 28, “Collaborating in 
Excel.”

	● A new XLOOKUP function is designed to improve on VLOOKUP and INDEX/MATCH functions. 
Excel also offers XMATCH. See Chapter 9, “Using powerful functions: logical, lookup, and 
database functions.”

	● New LET and LAMBDA functions let you store logic in a formula. See Chapter 10, “Using 
names, LET, LAMBDA, and Data Types in Excel.”

	● There are new features in Power Query (found in the Get & Transform group on the Data 
tab). You can now import from PDF files. You can also define your own custom data types. 
Read about Power Query in Chapter 13, “Transforming data with Power Query.”

	● Data types improve with the ability to return photos and arrays. There are several new 
categories from Wolfram including weather history for all cities. See Chapter 10, “Using 
names, LET, LAMBDA, and Data Types in Excel.”

	● The artificial-intelligence Ideas feature is re-branded as “Analyze Data.” The new version 
will create dynamic array formulas and allow you to ask a question about your data. Excel 
analyzes up to 250,000 cells of data and uses artificial intelligence to provide more than 
30 charts. For now, this feature is exclusive to Office 365. See Chapter 15, “Using pivot 
tables to analyze data.”

	● Although this book covers VBA as the macro language, there is one new interesting fea-
ture in programmability: A new TypeScript macro language is available for Excel Online.

The Excel team continues to innovate, with several new features planned for the upcoming 
years.
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Who this book is for
This book is for anyone who uses Excel twenty hours a week or more. Whether you use Excel for 
organizing your to-do list or to analyze 5 million rows of call center data every day, this book 
includes the information you need to solve problems quickly and easily.

Assumptions about you
I like to believe most of my readers use Excel 40 hours a week, and those are the weeks you are 
on vacation. At the very least, I’m assuming you regularly use Excel for your job. You are com-
fortable using Excel formulas beyond AutoSum. You likely know and use VLOOKUP and Pivot 
Tables regularly. You are looking for the fastest and most efficient ways to finish tasks in Excel.

How this book is organized
This book gives you a comprehensive look at the various features you will use. This book is 
structured in a logical approach to all aspects of using the Windows-based versions of Excel, 
with some mentions of Excel Online when there is important functionality available only in Excel 
Online.

Part I, “The Excel interface,” covers the ribbon, customizing Excel, and keyboard shortcuts.

Part II, “Calculating with Excel,” covers all Excel calculation functions.

Part III, “Data analysis with Excel,” covers Power Query, pivot tables, and other features that help 
you perform data analysis.

Part IV, “Excel visuals,” covers charting, 3D Map, and collaborating in Excel.

About the companion content
I have included the Excel workbooks I used to create the screenshots in this book to enrich your 
learning experience. You can download this book’s companion content from the following 
page:

MicrosoftPressStore.com/Excel365insideout/downloads

The companion content includes the following:

	● Workbooks used to create the examples in the workbook

	● Sample data that you can use to practice the concepts in the book

	● VBA macros from Chapter 19
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Support and feedback
The following sections provide information on errata, book support, feedback, and contact 
information.

Errata, updates, and book support
We’ve made every effort to ensure the accuracy of this book and its companion content. You 
can access updates to this book—in the form of a list of submitted errata and their related 
corrections—at:

MicrosoftPressStore.com/Excel365insideout/errata

If you discover an error that is not already listed, please submit it to us at the same page.

For additional book support and information, please visit MicrosoftPressStore.com/Support.

Please note that product support for Microsoft software and hardware is not offered through 
the previous addresses. For help with Microsoft software or hardware, go to http://support.
microsoft.com.

Stay in touch
Let’s keep the conversation going! We’re on Twitter:

http://twitter.com/MicrosoftPress

http://twitter.com/MrExcel
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CHAPTER 3

Customizing Excel

3erforming a simple ribbon modification 49

Adding a new ribbon tab �1

Sharing customi]ations with others �2

4uestions about ribbon customi]ation ��

Using the Excel Options dialog box ��

Options to consider ��

)ive Excel oddities ��

The Excel Options dialog box offers hundreds of changes you can make in Excel. This chapter 
walks you through examples of customizing the ribbon and discusses some of the important 
option settings available in Excel.

3erforming a simple ribbon modification
Suppose that you generally like the ribbon, but there is one icon that seems to be missing. You 
can add icons to the ribbon to make it customized to your preference. If you feel the Data tab 
would be perfect with the addition of a pivot table icon, you can add it (see Figure 3.1).

)igure �.1  Decide where the new command should go on the ribbon.

To add the pivot table command to the Data tab, follow these steps:

1. Right-click the ribbon and select Customize The Ribbon.

2. In the right list box, expand the Data tab by clicking the + sign next to Data.

3. Click the Sort & Filter entry in the right list box. The new group will go after this entry.

4. Click the New Group button at the bottom of the right list box. A New Group (Custom) 
item appears after Sort & Filter, as shown in Figure 3.2.
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)igure �.2 Commands must be added to a new group. 

5. While the New Group is selected, click the Rename button at the bottom of the list box. 
The Rename dialog box appears.

6. The Rename dialog box offers to let you choose an icon and specify a name for the group. 
The icon is shown only when the Excel window is too small to display the whole group. 
Choose any icon and type a display name of Pivot. Click OK.

7. The left list box shows the popular commands. You could change Popular Commands to 
All Commands and scroll through 2,400 commands. However, in this case, the commands 
you want are on the Insert tab. Choose All Tabs from the top-left drop-down menu. 

8. Expand the Insert tab, and then expand Tables. Click PivotTable in the left list box. 

9. Click the Add button in the center of the dialog box to add PivotTable to the new 
custom Pivot group on the ribbon. Excel automatically advances to the next icon of 
Recommended PivotTables. Click Add again.

10. In the drop-down menu above the left list box, select All Commands. The left list box 
changes to show an alphabetical list of all commands.
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11. Scroll through the left list box until you find PivotTable And PivotChart Wizard. This is the 
obscure entry point to create Multiple Consolidation Range pivot tables. Select that item 
in the left list box. Click Add. At this point, the right side of the dialog box should look like 
Figure 3.3.

)igure �.� Three new icons have been added to a new custom group on the Data tab.

12. Click OK.

Figure 3.4 shows the new group in the Data tab of the ribbon.

)igure �.� The results appear in the ribbon.

Adding a new ribbon tab
To add a new ribbon tab, follow these basic steps:

1. Right-click the ribbon and select Customize The Ribbon.

2. Click New Tab and rename the tab.

3. Add New Group(s) to the new tab.

4. Add commands to the new groups.

As you go through the steps to add a new ribbon tab, you will discover how absolutely limit-
ing the ribbon customizations are. You have no control over which items appear with large 
icons and which appear with small icons. This applies even to galleries. If you add the Cell Styles 
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gallery to a group on the ribbon, it always appears as an icon instead of a gallery, even if it is the 
only thing on the entire ribbon tab (see the left icon in Figure 3.5). The workaround is to add an 
entire built-in group to the tab. On the right of Figure 3.5, the entire Styles group was added. 
The Cell Styles gallery is now allowed to appear as a gallery.

Added Group

Added
Icon

)igure �.�  When added to a custom group, a gallery is reduced to a single icon with a drop-down 
menu.

TROUBLESHOOTING
When customizing the ribbon using this interface, you cannot control which icons 
appear large and which appear small in the ribbon.

The Excel ribbon contains a logical mix of large icons for important features and small 
icons for minor features. ,f \ou would liNe to create a new group, \ou cannot control 
which icons will be small and which will be large.

You can either learn RibbonML or use a third�part\ tool such as Ribbon &ommander 
to create custom ribbon tabs. Tr\ a free trial of Ribbon &ommander at https://mrx.cl/
ribboncommander.

Sharing customi]ations with others
If you have developed the perfect ribbon customization and you want everyone in your depart-
ment to have the same customization, you can export all the ribbon customizations.

To export the changes, follow these steps:

1. Right-click the ribbon and select Customize The Ribbon.

2. Below the right list box, select Import/Export, Export All Customizations.

3. Browse to a folder and provide a name for the customization file. The file type will be 
.exportedUI. Click OK.

4. In Windows Explorer, find the .exportedUI file. Copy it to a coworker’s computer.
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5. On the coworker’s computer, repeat step 1. In step 2, select Import Customization File. 
Find the file and click OK.

NOTE
This is an all�or�nothing proposition. You cannot export \our changes to one custom tab 
without exporting \our changes to the 'ata and +ome tabs.

4uestions about ribbon customi]ation
Can the customizations apply only to a certain workbook?

No. The Customize the Ribbon command in Excel applies to all workbooks.

Can I reset my customizations and go back to the original ribbon?

Right-click the ribbon and select Customize The Ribbon. Below the right list box, select Reset ! 
Reset All Customizations.

How can I get complete control over the ribbon?

Learn RibbonX and write some VBA to build your own ribbon.

 ➤ )or more information on building \our own ribbon, see RibbonX: Customizing the Office 
2007 Ribbon, b\ Robert Martin, .en 3uls, and Teresa +ennig �:ile\, ,S%N ����1�1112�.

These ribbon customizations are really lacking. Is there another option that doesn’t 
require me to write a program?

Yes, some third-party ribbon customization programs are available. For example, check out a 
free one from Excel MVP Andy Pope at https://andypope.info/vba/ribboneditor_2010.htm.

Using the Excel Options dialog box
Open the File menu and select Options from the left navigation pane to open the Excel Options 
dialog box. The dialog box has categories for General, Formulas, Data, Proofing, Save, Lan-
guage, Ease Of Access, Advanced, Customize Ribbon, Quick Access Toolbar, Add-Ins, and Trust 
Center. The Trust Center leads to another 13 categories.

To the Excel team’s credit, they tried to move the top options to the General category. Beyond 
those 19 settings, though, are hundreds of settings spread throughout 24 categories in the 
Excel Options and Trust Center. Table 3.1 gives you a top-level view of where to start looking for 
settings.
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Table 3.1 Excel Options dialog box settings

&ategor\ T\pes of Settings
General The most commonly used settings, such as user interface settings, the default 

font for new workbooks, number of sheets in a new workbook, customer 
name, and Start screen.

Formulas All options for controlling calculation, error-checking rules, and formula set-
tings. Note that options for multithreaded calculations are currently consid-
ered obscure enough to be on the Advanced tab rather than on the Formulas 
Tab.

Data The data category is new in 2017. It offers the new Edit Default Layout for 
pivot tables, several other pivot table options, and then a series of check-
boxes to bring back the legacy Get Data categories. When Power Query 
replaced Get Data on the Data tab of the ribbon, the old legacy icons were 
removed.

Proofing Spell-check options and a link to the AutoCorrect dialog box.
Save The default method for saving, AutoRecovery settings, legacy colors, and 

web server options.
Language Choose the editing language, ToolTip language, and Help language.
Ease of Access Options available are Provide Feedback With Sound, Provide Feedback With 

Animation, Screen Tip Style, and the default document font size.
Advanced All options that Microsoft considers advanced, spread among 15 headings.
Customize 
Ribbon

Icons to customize the ribbon.

Quick Access 
Toolbar

Icons to customize the Quick Access Toolbar (QAT).

Add-Ins A list of available and installed add-ins. New add-ins can be installed from 
the button at the bottom of this category.

Trust Center Links to the Microsoft Trust Center, with 13 additional categories.

*etting help with a setting
Many settings appear with a small i icon. If you hover the mouse near this icon, Excel displays a 
super ToolTip for the setting. The ToolTip explains what happens when you choose the setting. 
It also provides some tips about what you need to be aware of when you turn on the setting. 
For example, the ToolTip in Figure 3.6 shows information about the calculation settings. It also 
explains that you should use the F9 key to invoke a manual calculation.
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)igure �.�  The i button explains many settings. 

Inside OUT
The Excel team is actively listening to ideas suggested by their customers. Several of the 
settings in the following section were suggested by customers.

,f \ou have a great idea that would maNe Excel easier, post \our idea to Excel.User9oice 
.com. &reate a good title and use a slightl\ humorous tone when writing up how \our 
idea would maNe the worN life of millions of people easier.

After posting \our idea, others can vote for \our idea. As others browsing https://
msfeedbackprod.powerappsportals.com/feedback/ read \our idea, the\ can vote. ,f \ou 
get above the 2���vote level, it is liNel\ that \our idea will be added to a future release of 
Office ���.

Recent new options in Excel
Excel today offers several new settings:

1. When Using Multiple Displays is found in the General category. Excel now supports newer 
High DPI displays, but many people might have two-monitor setups with one High DPI 
display and one older display. If you have problems when moving Excel between displays, 
choose Optimize For Compatibility from this setting.

2. Excel introduced data types for stocks, currency, geography, and more. In an effort to 
make the feature discoverable, if you enter city names into a few cells, Excel can offer 
to convert those cells to a Geography Data Type. This is great at first, but if it becomes 
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bothersome, unselect Show Convert To Data Types When Typing from the General 
category.

3. Excel offers a Search box in the title bar. This is designed for finding commands when you 
can’t find them on the ribbon. If you think the Search box is taking up too much space, 
select Collapse The Microsoft Search Box By Default. It is found in the General category.

4. Microsoft added a dark mode to Excel. Use the Office Theme drop-down menu in the 
General category.

5. Near the bottom of the General category, you can assign which file extensions will open 
in Excel and ask Excel to notify you if it is not the default program for .XLSX and .XLSM 
files.

6. With the introduction of Dynamic Arrays, the Implicit Intersection behavior is different. If 
you attempt to write a formula with # in the wrong places, Excel can warn you that the 
formula is not compatible with older versions of Excel. It offers to change the formula so 
it is backward compatible, as shown in Figure 3.7. To check any random formula, enter 
=@(the formula) and see if Excel shows a dialog box. To turn off this behavior, on the 
Formulas category, unselect Suggest Formula Variations That Are Supported By Older 
Versions of Excel.

)igure �.�  The # will make sure that a formula designed to return a single value won’t return 
an array in earlier versions of Excel.

7. There are two new error-checking options in the Formulas category. A warning about 
a Misleading Number Format appears if your formula points to a numeric cell, but the 
formula is formatted as a date, as shown in Figure 3.8. By choosing Update Format, the 
number format from the source cell will be copied to the formula cell. Another new error-
checking option is Cells Containing Data Types That Couldn’t Refresh. This alerts you if 
the linked data type cell could not be refreshed.
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)igure �.�  If a cell formatted as a date is pointing to cells formatted as a number, the 
Misleading Number Format warning displays.

8. Default PivotTable Layout is found in the new Data category. Change the default layout 
for all future pivot tables. Several items in the new Data category were moved to the Data 
category from the Advanced category.

9. Show Legacy Data Import Wizards is a series of seven choices in the new Data category. 
The Power Query tools debuted in Excel 2016 on the Data tab of the ribbon. These tools 
became so popular, Microsoft decided to remove the old Get External Data group from 
the ribbon, but some people had specific reasons why they liked the old icons. You can 
now add those old icons back by choosing From Access, From Web, From Text, From SQL 
Server, From OData Data Feed, From XML Data Import, or From Data Connection. If you 
choose something from this area, it will appear hidden on the ribbon. Look in Data, Get 
Data, Legacy Wizards.

10. Show Data Loss Warning when Editing Comma Delimited Files (
.csv) is found in the 
Save category. Excel used to nag you whenever you opened a file in CSV format. If you 
did not save the file as XLSX, it would warn you that you are about to lose formulas 
and formatting. A lot of people were tired of the nagging, and Microsoft turned off the 
nagging by default. If you need to be nagged, you can turn it back on here.

11. A new Cache Settings in the Save category controls how many days to keep files in the 
Office document cache and lets you empty the cache.

12. The Ease Of Access category is new in Excel 2019. You can choose to Provide Feedback 
With Sound and choose a Modern or Classic sound scheme. The new part is the Modern 
sound scheme. The annoying Classic Sound Scheme was previously the only choice in the 
Advanced category. You can turn off Animations. The choice to control whether Screen 
Tips are shown is repeated here from the General category. You can set the Default Font 
Size used in the document, and you can choose to turn off the calculation Function 
Screen Tips.
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13. Use Pen To Select and Interact By Default is new in the Advanced category. If you prefer 
using a touchscreen, you can change the default behavior of touch.

14. Hyperlinks to Excel files stored in the cloud might open in Excel Online. If you prefer 
them to open in the desktop version of Excel, there is a new setting. The Link Handling 
subcategory is the third subcategory in the Advanced category. Choose Open Supported 
Hyperlinks To Office Files In Desktop Apps.

15. Excel lets you control how many recent files appear when you choose File ! Open. The 
new Find Show This Number Of Recent Unpinned settings controls how many recent 
folders will be shown. 

Using AutoRecover options
For many versions, Excel periodically saves a copy of your work every 10 minutes. If your com-
puter crashes, the recovery pane offers to let you open the last AutoRecovered version of the 
file. This feature is sure to save you from retyping data that might have otherwise been lost.

Another painful situation occurs when you do not save changes and then close Excel. Yes, Excel 
asks if you want to save changes for each open document, but this question usually pops up at 
5:00 p.m. when you are in a hurry to get out of the office. If you are thinking about what you 
need to do after work and not paying attention to which files are still open, you might click No 
to the first document and then click No again and again without noticing that the fifth open 
document was one that should have been saved.

Another scenario involves leaving an Excel file open overnight only to discover that Windows 
Update decided to restart the computer at 3 AM. After being burned a dozen times, you can 
change the behavior of Windows Update to stop doing this. However, if Windows Update 
closed Excel without saving your documents, you can lose those AutoRecovered documents.

A setting introduced in Excel 2010 has Excel save the last AutoRecovered version of each open 
file when you close without saving. This setting is on the Save category of Excel Options and is 
called Keep The Last AutoRecovered Version If I Close Without Saving.

&ontrolling image si]es
An Image Size & Quality section appears in the Advanced category. Most people add a photo 
to dress up the cover page of a document. However, you probably don’t need an 8-megapixel 
image being saved in the workbook. By default, Excel compresses the image before saving the 
file. You can control the target output size using the drop-down menu in Excel options. Choices 
include 96ppi, 150ppi, and 220ppi. The 96ppi setting will look fine on your display. Use 220ppi 
for images you will print. If you want to keep your images at the original size, you can select the 
Do Not Compress Images In File setting.
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Options to consider ��

You should also understand the Discard Editing Data check box. Suppose that you insert an 
image in your workbook and then crop out part of the photograph. If you do not enable 
Discard Editing Data, someone else can come along and uncrop your photo. This can be an 
embarrassing situation³just ask the former TechTV co-host who discovered certain bits of pho-
tographs were still hanging around after she cropped them out.

:orNing with protected view for files originating from the 
Internet
Starting in Excel 2010, files from the Internet or Outlook initially open in protected mode. This 
mode gives you a chance to look at the workbook and formulas without having anything mali-
cious happen. Unfortunately, you cannot view the macro code while the workbook is in pro-
tected view.

If you only want to view or print the workbook, protected mode works great. One statistic says 
that 40% of the time, people simply open a document and never make changes to it.

After you click Enable Editing, Excel will skip protected mode the next time you open the file.

:orNing with Trusted 'ocument settings
By default, Excel warns you about all sorts of things. If you open a workbook with macros, links, 
external data connections, or even the new WEBSERVICE function, a message bar appears above 
the worksheet to let you know that Excel disabled those “threats.”

If you declare a folder on your hard drive to be a trusted folder, you can open those documents 
without Excel warning you about the items. Visit File, Options, Trust Center, Trust Center Set-
tings, Trusted Locations to set up a trusted folder.

Starting in Excel 2010, if you open a file from your hard drive and enable the content, Excel 
automatically enables that content the next time. The inherent problem here is that if you open 
a file and discover the macros are bad, you will not want those macros to open the next time 
automatically. There is no way to untrust a single document other than deleting, renaming, or 
moving it. Instead, you have to go to the Trusted Documents category of the Trust Center where 
you can choose to clear the entire list of trusted documents.

Options to consider
Although hundreds of Excel options exist, this section provides a quick review of options that 
might be helpful to you:

1. Save Files In This Format in the Save category. If you regularly create macros, choose the 
Excel Macro-Enabled Workbook as the default format type.

2. Update your Default Local File Location on the Save tab. Excel always wants to save 
new documents in your My Documents folder. However, if you always work in the C:?
AccountingFiles? folder, update the default folder to match your preferred location.
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�� Chapter 3 Customizing Excel

3. Show This Number Of Recent Workbooks has been enhanced dramatically since Excel 
2003. Whereas legacy versions of Excel showed up to nine recent workbooks at the 
bottom of the File menu, Excel allows you to see up to 50 recent workbooks in the Open 
category of the File menu. You can change this setting by visiting the Display section of 
the Advanced category.

4. Edit Custom Lists has been moved to the General section of the Advanced category. 
Custom lists add functionality to the fill handle, allow custom sort orders, and control how 
fields are displayed in the label area of a pivot table. Type a list in the correct sequence in 
a worksheet. Edit Custom Lists and click Import. Excel can now automatically extend items 
from that list, the same as it can extend January into February, March, and so on.

5. Make Excel look less like Excel by hiding interface elements in the three Display sections 
of the Advanced category. You can turn off the formula bar, scrollbars, sheet tabs, row 
and column headers, and gridlines. You can customize the ribbon to remove all main tabs 
except the File menu. The point is that if you design a model to be used by someone who 
never uses Excel, the person can open the model, plug in a few numbers, and get the 
result without having to see the entire Excel interface.

6. Show A Zero In Cells That Have Zero Value is in the Display Options For This Worksheet 
section of the Advanced category. Occasionally people want zeros to be displayed as 
blanks. Although a custom number format of 0;-0;; will do this, you can change the 
setting globally by clearing this option.

7. Group Dates in the AutoFilter Menu is in the Display Options For This Workbook section 
of the Advanced category. Starting with Excel 2007, date columns show a hierarchical 
view of years, months, and days in the AutoFilter drop-down menu. If you like the old 
behavior of showing each date, turn off this setting.

8. Add a folder on your local hard drive as a trusted location. Files stored in a trusted 
location automatically have macros enabled and external links updated. If you can trust 
that you will not write malicious code, then define a folder on your hard drive as a trusted 
location. From Excel Options, select the Trust Center category and then Trust Center 
Settings. In the Trust Center, select Trusted Locations, Add New Location.

)ive Excel oddities
You might rarely need any of the features presented in this section. However, in the right cir-
cumstance, they can be time-savers.

1. Adjust the gridline color in the Display section of the Advanced category. If you are 
tired of gray gridlines, you can get a new outlook with bright red gridlines. I’ve met 
people who have changed the gridline color and can attest that nothing annoys an old 
accountant more than seeing bright red gridlines.
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Five Excel oddities �1

2. Allow negative time by switching to the 1904 date system in the General section of the 
Advanced category. Excel never allows a time to return a negative time. However, if you 
are tracking comp time and you allow people to borrow against future comp time, it 
might be nice to allow negative time. In this case, switch to the 1904 date system to have 
up to four years of negative time. Use caution when changing this setting. All existing 
dates in the workbook will shift by approximately four years.

3. Put an end to the green triangles on your account numbers stored as text. Most of the 
green triangle indicators are useful. However, if you have a column of text account 
numbers in which most values are numbers, seeing thousands of green triangles can 
be annoying. Also, the green triangles can hide other, more serious problems. Clear the 
Numbers Formatted As Text or Preceded By An Apostrophe in the Error Checking Rules 
check box in the Formulas category.

4. Automatically Insert A Decimal Point replicates the antique adding machines that 
were office fixtures in the 1970s. When working with a manual adding machine, it was 
frustrating to type decimal points. You could type 123456, and the adding machine 
would interpret the entry as 1,234.56. If you find that you are doing massive data entry 
of numbers in dollars and cents, you can have Excel replicate the old adding machine 
functionality. After enabling this setting, you can indicate how many digits of the number 
should be interpreted as being after the decimal point. The only hassle is that you need to 
enter $5 as 500. The old adding machines actually had a 00 key, but those are long since 
gone.

5. Change Dwight to Diapers using AutoCorrect Options. If you were a fan of the NBC 
sitcom The Office, you might remember the 2007 episode in which Jim allegedly put 
a macro on Dwight’s computer that automatically changed the typed word Dwight to 
Diapers. However, this doesn’t require a macro. From Excel Options, choose the Proofing 
Category and then click the AutoCorrect Options button. On the AutoCorrect tab, you 
can type new correction pairs. In this example, you would type Dwight into the Replace 
box and Diapers into the With box. The next time someone types Dwight and then a 
space, the word will automatically change to Diapers. You can also remove correction 
pairs by selecting the pairs and then pressing Delete. For example, if you hate that 
Microsoft converts (c) to �, you can delete that entry from the list.
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Symbols
	 �ampersand� operator, Moining text, 

121

 wildcard, ���
# �at� operator, implicit intersections, 

12�
#Mentions, sharing worNbooNs, ���, 

���, ��2
�� �absolute references�, �����

avoiding with names, 260
external workbook links, 290

� �dollar signs�
adding to references, 79
simplifying with F4 key, 99-101

« �ellipsis�, ´Moreµ command, 2�
� � �parentheses�

functions, 133
multiple sets of, 117-118
overriding order of operations, 116
stacking, 117-118

����� errors, 11�
�),EL'� errors, 11�
�&AL& errors, 11�
�',9��� errors, 11�
�N�A errors, 1��
�N�A� errors, 11�, 12�
�NULL� errors, 11�
�NUM� errors, 1��
�RE)� errors, 11�
� Spilled Range Operator, 112
�S3,LL� errors, 111, 11�
�9ALUE� errors, 11�, 1��
" wildcard, ���
2' arra\s, 2��
�' Maps

alternate maps, 603
animating

lines between points, 601
over time, 591

color, 589
column charts, 588
combining layers, 599

custom maps, 604-605
data entry, 594-597
Flat Map option, 600
heat maps, 588
labels, 602
photos, 598-600
resizing

columns, 599
panes, 600

rotating, 598
satellite photos, 600
shaded area maps, 587
store maps, 603
time choices, 601
tipping, 598
tours, 603
world maps, 600
zooming in/out, 589-594, 598

�' Models, ��1���2, �2�, �������
�� da\s. finding cell data from past, 

�������

A
A%S function, 1��
absolute recording, macros, ���
absolute references ����, �����

avoiding with names, 260
external workbook links, 290

accelerators, Ne\board
confusion, 66-68
drop-down menu lists, 66
Excel 2003

accelerators, 79-80
Alt shortcuts, 80-81

KeyTips, 63, 64
menus, backing up one level, 66
selecting

dialog boxes, 68
gallery options, 65
icons on ribbon, 64-65

accessibilit\
Accessibility Checker, 11-12

QAT
adding icons, 27
customizing, 28-29
KeyTips, 63-64
removing icons, 28
resequencing icons, 29
separating icons, 29

Slicers, 66
VBA, Help, 462
workbooks, 677-678

Action 3en, 1��1�, ���
active cells, bringing bacN into view, 

���
add�in functions, ���
adding

automatic subtotals, 339-341
columns with Power Query, 328
comments to formulas with N 

function, 221
dollar signs ($) to references, 79
fields in pivot tables, 373-374
headers/footers, 662-664
hyperlinks, 239
icons to QAT, 27
images to SmartArt, 628
multiple names at once, 259
numbers

AutoSum, 140-144
with status bar, 38-39
SUM function, 147-148

page breaks, 660
photos to 3D Maps, 598-600
pictures to headers, 663-664
slicers to pivot tables, 399-400
values, 366-367
watermarks to headers, 663-664
whitespace to icons, 35
worksheets, 35

add�ins
Analysis ToolPak, 769-771
Azure Machine Learning, 772
browsing, 766

Index
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��� add-ins

COM, 766
Data Streamer, 772
downloading, 766
Euro Currency Tools, 772
fake data, 773-774
Fast Excel, 774-775
Fuzzy Lookup, 771
Inquire, 768-769
Office Adds-In store, 767
People Graph, 773
Solver, 768
VBA, 765
Visio Data Visualizer, 772

addition�subtraction operations, order in formulas, 11�
adMectives, 9%A properties as, ��2
advanced filter, ������1

adding values, 366-367
combining duplicates, 366-367
criteria, 362-363
formulas, 362
removing duplicate results, 364-365
for unique records, 479-481

advanced formatting rules, ��2����
adverbs, 9%A parameters as, ������2
A**RE*ATE function, 1���1�1
aligning cells, �1�
alphabetical cross�reference list of functions, �������
alternate �' Maps, ���
Alt shortcuts, Excel 2���, ����1
ampersand operator �	�, Moining text, 121
anal\sis

Analysis ToolPak, 769-771
Monte Carlo, 444
sentiment analysis, Azure Machine Learning, 772

AN' function, 21�, 2��
animating

3D Maps over time, 591
lines between points in 3D Maps, 601

appending worNsheets
one worksheet

from every workbook in folder, 331-332
from one workbook, 332-333

Power Query, 331-333
applications, 9%A, ���

add-ins, 765
coding analogy, 458

collections, 459
examining recorded code, 463
object.method, 459

parameters, 460-462
properties, 462

collections, 459
Help, 462
macro recorder

default state, 449-450
parameters, 461-462

macros
advanced filters for unique records, 479-481
AutoFilter, 481-482
AutoSum errors, 466
customer reports, 477-484
customizing, 467-468
debugging, 476
deleting records from loops, 474-476
editing, 457
everyday-use macros, 467-468
finding last rows with data, 468-469
flow control, 471-473
GetOpenFilename, 467-468
GetSaveAsFilename, 467-468
If-End If constructs, 471-472
invoice register example, 454-456
looping through rows, 469
loops with FinalRow, 471
mail merges, 447-449
R1C1-style formulas, 464-465
range references, 470
recording, 446-452, 455-456
Relative References, 450
running, 453-454
running at full speed, 477
running in slow motion, 476
Select Case constructs, 472-473
selecting visible cells, 482-483
spillable formulas, 466
starting macro recorder, 451-452
testing records in loops, 473-474
troubleshooting, 477
variables, 463-464

object.method, 459
parameters, 460-462
properties, 462
R1C1-style formulas, 464-465
security, 446
spillable formulas, 466
variables, 463-464

applied filters, columns, ��2
ARA%,& function, 1��
argument arra\s, 2��
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AutoSave ���

arguments
AGGREGATE function, 149-150
DATEDIF function, 180
DATE function, 174
DAYS function, 183
DSUM function, 245
EOMONTH function, 183
EXACT function, 204
FIND function, 201
Function Arguments dialog box, 137-139
GETPIVOTDATA table, 242-243
HYPERLINK function, 239
INDIRECT function, 238
LAMBDA functions, 14
LEFT function, 196
MID function, 197
NETWORKDAYS function, 185
OFFSET function, 234
order in functions, 133
PROPER function, 189
REPT function, 203
RIGHT function, 196
SEARCH function, 201-202
SUBSTITUTE function, 202
testing, 275
TEXT function, 205
TIME function, 175
WEEKDAY function, 178
WEEKNUM function, 180
XLOOKUP function, 226-227

Arrange All, :indows 11, 1�
arranging

pictures, 645-647
slicers in pivot tables, 400-401

arra\s
2D arrays, 208
argument arrays, 240
creating, 273-274
data types

finding, 278-279
returning, 277

dynamic arrays
formulas, 297-300
functions, 301-313

LAMBDA function
calculations, 270-273
creating arrays, 273-274

random numbers, generating, 313
references

to entire arrays, 313
Spilled Range Operator (#), 112, 313

arrow Ne\ method, formula entr\, 1���1��

arrows, )ormula Auditing, 12��12�
art

Clip Art
arranging, 645-647
Artistic Effects, 642
Aspect Ratio, 638
brightness, 639-640
contrast, 639-640
cropping, 639
file sizes, 644
formatting with Ribbon tab, 637
inserting into Excel, 636-637
Picture Styles gallery, 640-642
removing backgrounds, 642-643
resizing, 637
rounded corners, 639
selecting, 645-647
sharpness, 639-640
transparency, 640

illustrations, 624
SmartArt, 623

adding images, 628
changing existing SmartArt to new styles, 627
common elements, 625
Hierarchical SmartArt, 629-630
inserting, 626-627
organization charts, 629-630
styles, 624-625

stickers, 624
WordArt, 623-633

artificial intelligence as inspiration for pivot tables, ��1����
Artistic Effects, ��2
Aspect Ratio, pictures, ���
assigning names, 2��
at �#� operator, implicit intersections, 12�
auditing

Formula Auditing arrows, 127-128
workbooks, Inquire add-in, 768-769
worksheets with Inquire, 491

AutoAverage, 1���1��
autocompleting functions, 1���1��
Auto&ount, 1���1��
AutoFilter

macros and, 481-482
pivot tables, 405-407

automaticall\ formatting formula cells, 12�
automatic headers, ��2
automatic page breaNs, ������1
automatic subtotals, adding, ������1
AutoSave, ���
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��� AutoSum

AutoSum, 1��. See also SUM function
errors, macros, 466
potential problems, 141-142
special tricks, 142-144

A9ERA*E,)S function, 1���1��
axis values, sparNlines, �1���1�
A= button, sorting data, ��
A]ure Machine Learning, ��2

B
bacNgrounds, removing from pictures, ��2
bacNing up one level in menus, ��
%acNstage view, )ile menu, ����2
%ASE function, 2���2��
%ing ,mages, inserting into Excel, ���
blanN criteria ranges, returning all records with 'SUM 

function, 2��
blanN pivot tables, ���, �������
blanN rows, pivot tables, ���
blanN worNbooNs, recording macros in, �������
bold text, �1���1�
borders, �1�
bottom of data, Mumping to, ��
brightness, pictures, �������
browsing

add-ins, 766
during Save As, 7

building
cell references with INDIRECT function, 237-238
formulas, 95
pivot tables with Power Pivot (Data Model), 413

built�in choices, sparNlines, �12��1�
built�in numeric formatting, ���
%Y&OL function, 2��
%YRO: function, 2��

C
&ache Settings, ��
&AL&ULATE function, �21��22
calculating

AVERAGEIFS function, 163-164
COUNTIFS function, 163-164
data with shortcut keys, 73-77
dates/time

DATEDIF function, 180-182
DATE function, 173-175
DATEVALUE function, 176-177
DAY function, 173
DAYS function, 183
EOMONTH function, 183

HOUR function, 173
ISOWEEKNUM function, 179
MINUTE function, 173
MONTH function, 173
NETWORKDAYS function, 184-186
NOW function, 171-172
SECOND function, 173
TIME function, 175
TIMEVALUE function, 177-178
TODAY function, 171-172
WEEKDAY function, 178-179
WEEKNUM function, 180
WORKDAY function, 183-185
YEARFRAC function, 180
YEAR function, 173

Excel as calculator, 131
exponents with POWER function, 162
formulas, 116

addition/subtraction operations, 117
multiplication/division operations, 117
parts of formulas, 130
slow motion, 129, 486-487
unary minus, 116

MAXIFS function, 163-164
MINIFS function, 163-164
pivot tables, 381

adding outside calculations, 382-383
changing field calculations, 383-385

square roots with SQRT function, 162-163
SUMIFS function, 163-165

case �text�
converting, 188-189
sorting data, 44
testing with EXACT function, 204

&atch Up button, ��2
&E,L,N* function, 1��
&E,L,N*.MAT+ function, 1��
&ELL function, 22�
cells

active cells, bringing back into view, 489
aligning, 514
AutoAverage, 144-145
AutoCount, 144-145
AutoSum, 141-144
Cell Styles, 525-527
centering, 520-523
column input cells, 431
conditional formatting, ISFORMULA function, 219-220
converting Geography Data Type, 55
dates, formatting, 125
direct precedents, showing, 126-127
displaying contents with shapes, 630-632
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charts ��1

distant cells, watching results of, 485-486
error cells, ignoring with AGGREGATE function, 149-151
finding

with data from past 30 days, 565-566
within three days of today, 565

formatting
aligning cells, 514
automatically, 124
Cell Styles, 525-527
dates, 125
Format Cells dialog box, 502-505
wrapping text, 533-534

formula cells, ISFORMULA function, 219-220
formulas, entering in many cells, 106
highlighting, 126

Greater Than, 557-559
Highlight Cells Rules, 556

implicit intersections, 102-112, 124
in-cell bar charts, 544-545
last records, finding with Ctrl+Down-Arrow key, 455
merging cells, 4, 520-523
names, 253

adding multiple names at once, 259
assigning, 254
navigating with Name dialog box, 255
valid names, 254-255
workbook-level names, 256-257

notes, 535-538
On-Grid ToolTips, 137
pivot tables

changing cells, 380
formatting cells, 379
retrieiving cells witjh GETPIVOTDATA function, 241-243

ranges, describing with numbers, 234-237
references

building/evaluating with INDIRECT function, 237-238
returning with XLOOKUP function, 232

row input cells, 431
selecting shortcut keys, 71-72
subsets, showing data bars, 548
symbols, inserting, 487
tall cells, smooth scrolling, 9
text cells

finding number of characters with LEN function, 198
locating characters in particular cells, 198-202

tracing dependents, 128
unselecting, 39-40
visible cells

selecting with macros, 482-483
totaling with SUBTOTAL function, 156

Watch Window, 129

wide cells, smooth scrolling, 9
wrapping text, 533-534

centering
cells, 520-523
reports on page, 669-670

changing
cells, pivot tables, 380
default fonts, 532-533
field calculations, pivot tables, 383-385
font size/typeface, 515
margins (worksheets), 657
Page Setup settings, 668
pivot tables

cell changes, 380
reports with field lists, 374-376

printer properties, 668
ribbon, resizing Excel, 24
rolling back changes, Version History, 692-693
Show Changes within last 60 days, 6
SmartArt (existing) to new styles, 627
themes, 528
tracking changes

Catch Up button, 692
Show Changes, 690
Version History, 690-693

&+AR function, 1�2�1��
characters �text�

generating with
CHAR function, 192-195
SUBSTITUTE function, 192
UNICHAR function, 192-195

individual characters, formatting, 531-532
replacing with SUBSTITUTE function, 202
viewing character codes, 195

charts
column charts, 588, 607, 617
combo charts, 577
creating, 573-574
filled map charts, geographic data, 580
formatting, 576
funneling data, 575
histogram charts, frequency distribution, 577-578
line charts, sparklines, 607
missing data, forcing not to plot with NA function, 221-223
organizational charts, 629-630
paintbrush icon, 574-575
Pareto charts, 578
pasting new data, 580-583
people charts, People Graph, 773
pie charts, small pie slices, 583-584
plotting, forcing not to plot missing data with NA function, 

221-223
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plus icon, 576
Recommended Charts, choosing from, 573-574
stacked column charts, sparklines, 617
styles, 574-575, 584-585
waterfall charts, financial data, 579
Win/Loss charts, sparklines, 607, 613, 616
X Y Scatter charts, 581-583

checN boxes, filtering pivot tables, �������
&hecN )or Errors, �
&+OOSE function, 21��21�, 22�
&+OOSE&OLS function, 2��
&+OOSERO:S function, 2��
choosing

from Recommended Charts, 573-574
paper size, printing, 657
printers, 666
random items from lists, INDEX function, 158
shape styles, 632
slicer items, 79
themes, 528
what to print, 667

cleaning data, )lash )ill, ����1
clearing

filters, 353
pivot table filters, 395
Recent Workbooks list, 32

&lip Art
arranging, 645-647
Artistic Effects, 642
Aspect Ratio, 638
brightness, 639-640
contrast, 639-640
cropping, 639
file sizes, 644
formatting with ribbon tab, 637
inserting into Excel, 636-637
Picture Styles gallery, 640-642
removing backgrounds, 642-643
resizing, 637
rounded corners, 639
selecting, 645-647
sharpness, 639-640
transparency, 640

clipboard, pasting from, �
closed worNbooNs, opening with linNs, 2��
closing

Backstage view, File menu, 32
VBA Editor, 5

cloud computing, storing worNbooNs, ���
&O'E function, 1��
&ode pane, 9%E, ���

coding analog\, 9%A, ���
collections, 459
examining recorded code, 463
object.method, 459
parameters, 460-462
properties, 462

collaboration, ���
access to workbooks, viewing, 677-678
criteria for success, 674
editing

etiquette, 681
multiple editors, same workbook, 680
presence, 680-681
vetoes, 681-682

filtering workbook data, Sheet Views, 683-686
presence, 680-681
sharing workbooks

#Mentions, 677, 687, 692
comments, 677, 687, 692
finding shared workbooks, 679-680
Notes, 689
notifications, 678-680
threaded comments, 688-689
tracking changes, Catch Up button, 692
tracking changes, Show Changes, 690
tracking changes, Version History, 690-693

sorting workbook data, Sheet Views, 683-686
success, criteria for, 674
user access, 677-678
workbooks

cloud storage, 674
OneDrive, 674
sharing during initial saves, 675
sharing, setting with expiration dates, 676-677
sharing with Share button, 676

collapsed subtotal view, sorting with largest customers at 
top, ��2����

collapsing tasN panes, 2�
collections, 9%A, ���
color

3D Maps, 589
cells, formatting in, 517-519
color scales, highlighting extremes, 549-550
custom numeric formatting, 512
data bars

creating, 545-546
customizing, 546-547
in-cell bar charts, 544-545
showing for subsets of cells, 548

Filter by Color, 356-357
heat maps, 543, 588
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COUNTA function ���

sorting data by, 43
sparklines, 614
themes, 529

column charts, ���, ���, �1�
column input cells, ��1
columns

2D arrays, 208
3D Maps, resizing columns, 599
adding with Power Query, 328
applied filters, 352
CHOOSECOLS function, 208
inserting Filtered Data, 4
LAMBDA function calculations, 269
reordering sorting data, 44
repeating, 658
subsets, selecting with FILTER function, 307
TOCOL function, 208
VECTORWRAP function, 208
widths, formatting, 519-520

&OM add�ins, ���
combining

duplicates, 366-367
filters, 352
formatting rules, 568-569
layers of 3D Maps, 599

combo charts, ���
commands

KeyTips, 63, 64
last command, repeating, 489
legacy keyboard commands, 81-89
“More” command, 22-23

comments
formulas, adding with N function, 221
legacy comments, 689
Notes, 689
printing, 670
sharing workbooks, 677, 687-689, 692
threaded comments, 688-689

comparing
dates, conditional formatting, 559-560
international text comparisons, 4

comparison operators, 212
compatibilit\ functions, �������
conditional formatting

date comparisons, 559-560
duplicate values, identifying, 560-561
extending reach of, 569
finding cells

with data from past 30 days, 565-566
within three days of today, 565

Greater Than, 557-559

Highlight Cells Rules, 556
highlighting

data from specific days of the week, 566
entire rows, 566-567
every other row, 567-568

ISFORMULA function, 219-220
pasting, 539
pivot tables, 570-571
rules

based on formulas, 564-565
combining, 568-569
top/bottom rules, 554-555

text containing values, 561-562
top/bottom rules, 554-555
unique values, identifying, 560-561

condition checNs
AND function , 213
OR function , 214

condition codes, custom numeric formatting, �12
conditionall\ sum records, 'SUM function, 2���2��
contextual ribbon tabs, 2�
contrast, pictures, �������
controls, worNsheets, ��
converting

2D arrays to a single column/row, 208
cells, Geography Data Type, 55
columns to 2D arrays, 208
Euro Currency Tools add-in, 772
formulas to values, right-drag menu, 289
numbers to text with BASE function, 207
pivot tables to dashboard formulas, 423, 424
rows to 2D arrays, 208
text case, 188-189
text dates

to real dates, DATEVALUE function, 176-177
to real times, TIMEVALUE function, 177-178

cop\ing
filtered results, 360
formatting to new worksheets, 540-541
formulas, 122-123, 538

double-clicking fill handle, 107
dragging fill handle, 107
Table tool (Ctrl+T), 108-109
with Ctrl+Enter key combination, 106

pivot tables for each customer, 407
sparklines, 620
subtotal rows only, 344-345
worksheets to new workbooks, 541

corner of selections, Mumping to, ��
&OUNT function, 1�2
&OUNTA function, 1�2
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��� COUNTIFS function

&OUNT,)S function, 1���1��
counting distinct pivot tables, �1���1�
creating

charts, 573-574
data bars, 545-546
sparklines, 608-612
themes

color, 529
fonts, 530
reusing effects, 530
saving, 530

criteria, 'SUM function
dates as criteria, 248
joining, 247-248
numbers as criteria, 248
ranges

blank ranges, returning all records, 246
miracle ranges, 249-250
simple ranges, 246

cropping pictures, ���
crossing tasNs off lists, ��
.&S9 files, turning on�off reminders, �����
&trl�%acNspace Ne\ combination, bringing active cells bacN 

into view, ���
&trl�clicN Ne\ combination, unselecting cells, �����
&trl�'own�Arrow Ne\ combination, handling variable 

numbers of rows, �������
&trl�Enter Ne\ combination, cop\ing formulas, 1��
&trl�T Ne\ combination �Table tool�, cop\ing formulas, 

1���1��
&trl�Up�Arrow Ne\ combination, finding last records, ���
&trl shortcut Ne\s, ��
cube functions, ��1���2
currenc\

conversion, Euro Currency Tools add-in, 772
data types, 280
displaying, 506

current ranges, selecting, ��
customers

largest customers, sorting collapsed subtotal view, 342-343
reports, creating, 477-484

customi]ing
3D Maps, 604-605
data bars, 546-547
data types, 335-337
headers, 663
lists, sorting data, 45
macros, everyday-use macros, 467-468
numeric formatting, 509-510

color, 512
condition codes, 512

dates, 512-513
decimal spaces, 511
scientific notation, 513
spaces, 511
text, 511
times, 512-513

pivot tables, 374-376
QAT, 28-29
sparklines, 612-614
text

bold text, 516-517
font size, 515
font typeface, 515
italic text, 516-517
rotating, 523-524
underline text, 516-517
vertical text, 523-524

&ut�out 3eople, 1��1�, �2�, �������
cutting formulas, 122�12�

D
dail\ dates

subtotaling by month, 348
summarizing daily dates into months, quarters, years, 

381-382
darN mode, ��
dashboard formulas, converting pivot tables to formulas, 

�2���2�
data bars

creating, 545-546
customizing, 546-547
in-cell bar charts, 544-545
subsets of cells, 548

database functions, 2��, ���
DGET function, 250-251
DSUM function, 244

blank criteria ranges returning all records, 246
conditionally sum records, 245-246
dates/numbers as criteria, 248
joining criteria, 247-248
miracle criteria ranges, 249-250
simple criteria ranges, 246

data cards, finding arra\s, 2���2��
data diagrams, 9isio 'ata 9isuali]er, ��2
data entr\

3D Maps, 594-597
shortcut keys, 73-77

'ata Model �3ower 3ivot�, ���
additional information, 426
benefits of, 426
Diagram view, 412
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definitions ���

hidden features, unlocking, 414
joining multiple tables, 410-411
limitations/workarounds, 424-426
pivot tables

building, 413
converting to formulas, 423-424
counting distinct, 414-416
creating medians with DAX measures, 418-421
including filtered items in totals, 416-418
time intelligence, DAX measures, 421-423

relationships between tables, creating, 411-412
'ata Streamer, ��2
'ata Table command, single variable changes, ���
data tables, what�if anal\ses, �������
data t\pes, 2���2��

Currency data type, 280
custom data types, 335-337
finding arrays, 278-279
returning arrays, 277
Stock data type, 280

data visuali]ations
color scales, highlighting extremes, 549-550
data bars

creating, 545-546
customizing, 546-547
in-cell bar charts, 544-545
showing for subsets of cells, 548

heat maps, 543
icon sets

hiding icons, 554
mixing icons, 554
moving numbers closer to icons, 552-553
segregating data, 550-551
setting up, 551-552

'ATE',) function, 1���1�2
dates�time, 1��

as criteria, DSUM function, 248
comparing, conditional formatting, 559-560
custom numeric formatting, 512-513
daily dates, subtotaling by month, 348
date and time functions, 709-711
date fields, filtering pivot tables, 405
Date Filters fly-out, pivot tables, 397
DATE function, 173-175
DATEDIF function, 180-182
DATEVALUE function, 176-177
DAY function, 173
DAYS function, 183
displaying, 507

elapsed time, calculating with
DATEDIF function, 180-182
DAYS function, 183
EOMONTH function, 183
YEARFRAC function, 180

expiration dates, setting in workbooks, 676-677
filters, 357-359
formatting, 41, 125, 168-170
grouping

dates into weeks, ISOWEEKNUM function, 179
dates into weeks, WEEKNUM function, 180
by day of the week, WEEKDAY function, 178, 179

HOUR function, 173
ISOWEEKNUM function, 179
joining text with, 121-122
MINUTE function, 173
MONTH function, 173
NETWORKDAYS function, 184-186
NOW function, 171-172
potential problems, 166-167
SECOND function, 173
stamps, 78
TIME function, 175
TIMEVALUE function, 177-178
TODAY function, 171-172
troubleshooting, 166-167
WEEKDAY function, 178-179
WEEKNUM function, 180
workdays, calculating with

NETWORKDAYS function, 184-186
WORKDAY function, 183-185

YEAR function, 173
YEARFRAC function, 180

'A; �'ata Anal\sis Expressions�
functions, 755-759
measures

medians, creating for pivot tables, 418-421
time intelligence, 421-423

'AY function, 1��
'AYS function, 1��
da\s of the weeN �specific�, highlighting data from, ���
debugging macros, ���
decimal places, custom numeric formatting, �11
decision maNing with ,) function, 211�21�
declaring worNbooN�level names, 2���2��
default fonts, changing, ��2����
definitions

ranges as tables, 108
text, viewing with Insights (Smart Lookup), 495-496
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��� deleting

deleting
ranges with merged cells, 4
records in loops, 474-476

delimiters
separating text, 489-490
splitting in new rows, 330-331

dependents, tracing, 12�
describing ranges with numbers, O))SET function, 2���2��
descriptive statistics, Anal\sis Tool3aN, ������1
'eveloper tab, ribbon, 2�
'*ET function, 2���2�1
diagrams

Diagram view, Power Pivot (Data Model), 412
Visio Data Visualizer, 772

dialog box launcher, 22�2�
dialog boxes, selecting, ��
direct precedents, showing, 12��12�
disabling macros with notifications, ���
displa\ing

cell contents with shapes, 630-632
currency, 506
dates, 507
fractions, 507
phone numbers, 508
scientific notation, 513
Social Security numbers, 509
times, 507
ZIP Codes, 508-509

distant cells, watching results of, �������
distinct counting, pivot tables, �1���1�
distributions �freTuenc\�, histogram charts, �������
division operations, order in formulas, 11�
division problems, finding remainders with MO' function, 

1���1�2
'ocument ,nspector, finding hidden content, ��
documenting worNsheets, )ORMULATE;T function, 

2�2�2��
dollar signs ���

absolute references ($$), 96-98
avoiding with names, 260
external workbook links, 290

adding to references, 79
simplifying entries with F4 key, 99-101

'ouble�%\te text functions, ���
double�clicNing fill handle, cop\ing formulas, 1��
downloading add�ins, ���
dragging fill handle, cop\ing formulas, 1��
drawing

Action Pen, 493
inking tools, 494-495

drop�down menus
lightning bolt, 109
navigating, 66

'SUM function, 2��
conditionally sum records, 245-246
criteria ranges

blank ranges returning all records, 246
miracle version, 249-250
simple ranges, 246

dates/numbers as criteria, 248
joining criteria

AND function, 247
OR function, 247-248

duplicates
combining, 366-367
removing from filtered results, 364-365
values, identifying with conditional formatting, 560-561

d\namic arra\s, ��
formulas, 102, 297-300
functions

FILTER function, 305-307, 363-364
RANDARRAY function, 304-305, 313
SEQUENCE function, 310-312
SORTBY function, 303-304
SORT function, 301-305
UNIQUE function, 309-310

E
editing

equations, 487, 488
formulas, showing direct precedents, 126-127
macros, 457
text, returning to original text with T function, 207
VBA Editor, 5
VBE, 457
workbooks, 33

etiquette, 681
multiple editors, same workbook, 680
presence, 680-681
vetoes, 681-682

effects �themes�, reusing, ���
elapsed time, calculating

DATEDIF function, 180-182
DAYS function, 183
EOMONTH function, 183
YEARFRAC function, 180

ellipsis �«�, More commands, 2�
engineering functions, �2����1
enlarging sparNlines, �1���2�
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filtering ���

entering
data, shortcut keys, 73-77
formulas

arrow key method, 103-105
mouse method, 103
same formulas in many cells, 106
spilling, 110-111

EOMONT+ function, 1��
eTuations, editing, �������
error handling

##### errors, 119
#CALC errors, 119
Check For Errors, 4
#DIV/0� errors, 118
#FIELD� errors, 119
formulas, 56
IFERROR function, 217-219
IFNA function, 219
ignoring error cells with AGGREGATE function, 149-151
magnitude of error, determining with ABS function, 159
#N/A errors, 134
#N/A� errors, 119-120
#NULL� errors, 119
#NUM� errors, 134
#REF� errors, 118
replacing error values when printing, 670
#SPILL� errors, 111, 119
Trace Error, 120
#VALUE� errors, 118, 134

etiTuette, editing worNbooNs, ��1
Euro &urrenc\ Tools add�in, ��2
evaluating

cell references, INDIRECT function, 237-238
formulas, 116

addition/subtraction operations, 117
multiplication/division operations, 117
parts of formulas, 130
slow motion, 129
unary minus, 116

ever\da\�use macros, customi]ing, �������
E;A&T function, 2��
Excel

as calculator, 131
Excel 2003

Alt shortcuts, 80-81
keyboard accelerators, 79-80

Excel 2016, upgrading from, 18-19
Help functions, 139-140
Microsoft 365 Excel, improvements to performance, 4
options, printing, 654

excluding parts of worNsheets from printing, ���

expanding formula bar, �����
exponents, calculating with 3O:ER function, 1�2
extending selections, Ne\board shortcuts, �2���
external worNbooN linNs, absolute references, 2��
extracting uniTue values with formulas, �����1�
extremes, highlighting with color scales, �������

F
)� Ne\

rectangular ranges, 101-102
repeating last command, 489
simplifying dollar sign entries, 99-101

)� loops, ��
faNe data add�in, �������
)ast Excel add�in, �������
field lists, changing pivot table reports, �������
fields

multiple fields, subtotaling, 347
pivot tables

adding fields, 373-374
changing calculations, 383-385

file extensions, opening, ��
)ile menu

Backstage view, 30-32
opening full screen, 30
Print panel, 652, 666

files
recent files, opening, 58
picture file sizes, 644

filled map charts, geographic data, ���
fill handle, cop\ing formulas, 1��
filtering

adding values, 366-367
advanced filters, 360-361

adding values, 366-367
combining duplicates, 366-367
criteria, 362-363
formulas, 362
removing duplicate results, 364-365
unique records, 479-481

AutoFilter
macros and, 481-482
pivot tables, 405-407

by color, 356-357
by selection, 353-356
clearing filters, 353
columns, applied filters, 352
combining

duplicates, 366-367
filters, 352
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��� filtering

copying filtered results, 360
data, inserting columns, 4
dates, 357-359
drop-down menu, resizing, 353
features of, 349
filtered rows, ignoring with AGGREGATE function, 149-151
FILTER function, 305-307, 363-364
formatting filtered results, 360
formulas, 305-306
numbers, 358-359
pivot tables

AutoFiltering, 405-407
check boxes, 395-396
clearing filters, 395
Date Filters fly-out, 397
dates, 405
including filtered items in totals, 416-418
Label Filter fly-out, 396-397
row label filter, 393-395
slicers, 399-404
Top 10 Filter dialog box, 398-399

reapplying filters, 353
refreshing filters, 353
removing duplicates from filtered results, 364-365
selecting multiple items, 351-352
text, 358-359
totaling filtered results, 360
using, 349-350
workbook data, Sheet Views, 683-686

finali]ing worNbooNs, ��
)inalRow, loops, ��1
financial data, waterfall charts, ���
financial functions, �������
finding

arrays, data types, 278-279
cells

with data from past 30 days, 565-566
within three days of today, 565

characters in text cells
with FIND function, 198-201
with SEARCH function, 200-202

Find dialog box, showing all options, 8
FIND function, locating characters in text cells, 198-201
functions

in Formulas tab, 135
with Insert Function dialog box, 136

hidden content with Document Inspector, 34
last rows with data, 468-469
lost ribbon commands, 25-26
near matches with Fuzzy Lookup, 771
number of characters in text cells with LEN function, 198

printing settings, 652-653
shared

documents, 680
workbooks, 679

first page numbers, controlling, ���
)lash )ill

cleaning data, 40-41
formatting dates, 41
mathematical transformations, 41
numbers, filling in, 41
troubleshooting, 41, 42

)lat Map option, �' Maps, ���
)LOOR function, 1��
)LOOR.MAT+ function, 1��
Áow control, macros

If-End If constructs, 471-472
Select Case constructs, 472-473

Áowing text in ranges, �������
Á\�out menus, 22
fonts

default fonts, changing, 532-533
size, changing, 515
themes, 530
typeface, changing, 515

footers�headers
adding pictures/watermarks, 663-664
automatic headers, 662
custom headers, 663
different headers/footers in same document, 664-665
scaling, 665

formatting, ���
3D Models, 624, 648-649
advanced formatting rules, 562-563
cells

aligning cells, 514
Cell Styles, 525-527
centering, 520-523
color, 517-519
merging, 520-523
wrapping text, 533-534

charts, 576
column widths, 519-520
conditional formatting

combining rules, 568-569
date comparisons, 559-560
extending reach of, 569
finding cells with data from past 30 days, 565-566
finding cells within three days of today, 565
Greater Than, 557-559
Highlight Cells Rules, 556
highlighting data from specific days of the week, 566
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formatting ���

highlighting rows, entire rows, 566-567
highlighting rows, every other row, 567-568
identifying duplicate/unique values, 560-561
ISFORMULA function, 219-220
pasting, 539
pivot tables, 570-571
rules based on formulas, 564-565
text containing values, 561-562
top/bottom rules, 554-555

copying to new worksheets, 540-541
Cut-out People, 624-648
data, shortcut keys, 73-77
dates/time, 41, 125, 168-170
filtered results, 360
Format Cells dialog box, 502-505
Format Painter, 539-540
formula cells automatically, 124
green bar formatting, 162
icons, 624, 647-648
illustrations, 624, 647-648
invoice registers, 454-456
macros, mail merges, 447-449
numbers

as text with TEXT function, 204-205
currency, 506
custom formats, 509-513
dates, 507
fractions, 507
leading zeroes, adding with BASE function, 206-207
phone numbers, 508
Social Security numbers, 509
times, 507
with built-in numeric formatting, 505
with Format Cells dialog box, 505
with Home tab, 503-505
with thousands separators, 506
ZIP Codes, 508-509

pictures, 624
arranging, 645-647
Artistic Effects, 642
Aspect Ratio, 638
brightness, 639-640
contrast, 639-640
cropping, 639
file sizes, 644
inserting Bing Images, 637
inserting Clip Art, 636-637
inserting from your computer, 635
inserting into Excel, 635
inserting multiple pictures at once, 635
inserting Stock Images, 636-637

Picture Styles gallery, 640-642
removing backgrounds, 642-643
resizing, 637
ribbon tab, 637
rounded corners, 639
Screen Clippings, 645
selecting, 645-647
sharpness, 639-640
transparency, 640

pivot tables
cells, 379
numeric fields, 378-379

quick formatting, 562-563
row heights, 519-520
rules, combining, 568-569
shapes, 623

choosing styles, 632
displaying cell contents, 630-632

SmartArt, 623
adding images, 628
changing existing SmartArt to new styles, 627
common elements, 625
Hierarchical SmartArt, 629-630
inserting, 626-627
organizational charts, 629-630
styles, 624-625

stickers, 624, 647-648
subscripts, 29
subtotal rows, 345-346
superscripts, 29
text

containing values, 561-562
returning to original text with T function, 207
Text That Contains formatting rule, 561-562
with mini toolbar, 36

text boxes, 623, 633-634
themes

changing, 528
choosing, 528
color, 529
components of, 528
creating, 529-530
fonts, 530
Office themes, 527-529
reusing effects, 530
saving, 530

time/dates, 168-170
traditional formatting, 501-503
WordArt, 623, 632-633
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��� formatting

worksheets
aligning cells, 514
bold text, 516-517
borders, 517
cell color, 517-519
cell notes, 535-538
Cell Styles, 525-527
centering cells, 520-523
changing default fonts, 532-533
column widths, 519-520
conditional formatting, 539
copying formatting to new worksheets, 540-541
copying formulas, 538
font size, 515
font typeface, 515
Format Painter, 539-540
italic text, 516-517
justifying text in ranges, 534-535
merging cells, 520-523
need for, 499-501
numeric formatting, built-in, 505
numeric formatting, currency, 506
numeric formatting, custom formats, 509-513
numeric formatting, dates, 507
numeric formatting, Format Cells dialog box, 505
numeric formatting, fractions, 507
numeric formatting, Home tab, 503-505
numeric formatting, phone numbers, 508
numeric formatting, Social Security numbers, 509
numeric formatting, thousands separators, 506
numeric formatting, times, 507
numeric formatting, ZIP Codes, 508-509
pasting formulas, 538-539
rotating text, 523-524
row heights, 519-520
saving, 530
text, individual characters, 531-532
themes, 527-530
traditional formatting, 501-503
underline text, 516-517
vertical text, 523-524
wrapping text, 533-534

)ormula Auditing arrows, 12��12�
)ormula Auto&omplete, 1���1��
formula bar, expanding, �����
formulas

##### errors, 119
absolute references ($$), 96-98

avoiding with names, 260
external workbook links, 290

advanced filter, 362

arrays
random numbers, generating, 313
references, Spilled Range Operator (#), 112

auditing, Formula Auditing arrows, 127-128
building, 95
#CALC errors, 119
calculating, 116

addition/subtraction operations, 117
multiplication/division operations, 117
parts of formulas, 130
slow motion, 129
unary minus, 116

cells
dates, 125
formatting automatically, 124
highlighting, 126
ISFORMULA function, 219-220
showing direct precedents, 126-127
tracing dependents, 128
Watch Window, 129

comments, adding with N function, 221
conditional formatting rules, 564-565
converting to values with right-drag menu, 289
copying, 122-123, 538

double-clicking fill handle, 107
dragging fill handle, 107
Table tool (Ctrl+T), 108-109
with Ctrl+Enter key combination, 106

cutting, 122, 123
data types, returning arrays, 277
#DIV/0� errors, 118
dollar signs ($)

absolute references ($$), 96-98, 260, 290
adding to references, 79
simplifying with F4 key, 99-101

dynamic array formulas, 102, 297-300
editing, showing direct precedents, 126-127
entering

arrow key method, 103-105
first formula, 95
mouse method, 103
same formula in many cells, 106
spilling, 110-111

error checking, 56
evaluating, 116

addition/subtraction operations, 117
multiplication/division operations, 117
parts of formulas, 130
slow motion, 129
unary minus, 116
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functions ��1

F4 key
rectangular ranges, 101-102
simplifying dollar sign entries, 99-101

#FIELD� errors, 119
filtering, 305-306
formatting cells automatically, 124
highlighting cells, 126
implicit intersections, 102, 111-112, 124
incompatible, 56
joining text, 121-122
links, creating, 291
mixed references, 98-99
#N/A� errors, 119-120
names

applying retroactively, 258-259
simplifying formulas with named ranges, 257-258

#NULL� errors, 119
operators, 115-116
order of operations, 116-118
pasting, 538-539
pivot tables, converting to dashboard formulas, 423-424
R1C1-style formulas, macros, 464-465
rectangular ranges, F4 key, 101-102
#REF� errors, 118
relative references, 96, 122-123
retroactively applying names to formulas, 258-259
seeing all formulas, 126
Show Formulas mode, 126
simplifying with named ranges, 257-258
slow motion calculations, 486-487
sorting, 301-305
spearing formulas, 148
#SPILL� errors, 111, 119
spilling, 110-111, 466
storing results with LET function, 260-264
troubleshooting

evaluating in slow motion, 129
evaluating parts of formulas, 130
Formula Auditing arrows, 127-128
highlighting cells, 126
seeing all formulas, 126
showing direct precedents, 126-127
tracing dependents, 128
Watch Window, 129

turning data, TRANSPOSE function, 240
unique values, extracting, 308-310
unsupported, 56
#VALUE� errors, 118
values versus, 94

)ormulas tab, 1���1��
)ORMULATE;T function, 2�2�2��

fractions, displa\ing, ���
freTuenc\ distributions, histogram charts, �������
)RE4UEN&Y function, ���
full screen )ile menu, opening, ��
full speed, running macros in, ���
)unction Arguments dialog box, 1���1��
functions

ABS function, 159
add-in functions, 736
AGGREGATE function, 149-151
alphabetical cross-reference list, 738-753
AND function, 213, 247
ARABIC function, 158
arguments, order of, 133
AutoAverage, 144-145
autocompleting, 135-136
AutoCount, 144-145
AutoSum, 140-144. See also SUM function
AVERAGEIFS function, 163-164
BASE function, 206-207
BYCOL function, 269
BYROW function, 269
CALCULATE function, 421-422
CEILING function, 154
CEILING.MATH function, 154
CELL function, 223
CHAR function, 192-195
CHOOSE function, 216-217, 224
CHOOSECOLS function, 208
CHOOSEROWS function, 208
CODE function, 195
compatibility, 736-738
COUNT function, 152
COUNTA function, 152
COUNTIFS function, 163-164
cube functions, 731-732
database functions, 243, 735

DGET function, 250-251
DSUM function, 244-250

date and time functions, 709-711
DATE function, 173, 174, 175
DATEDIF function, 180-182
DATEVALUE function, 176-177
DAX functions, 755-759
DAY function, 173
DAYS function, 183
DGET function, 250-251
Double-Byte text, 708
DSUM function, 244

blank criteria ranges returning all records, 246
conditionally sum records, 245-246
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��2 functions

dates/numbers as criteria, 248
joining criteria, AND function, 247
joining criteria, OR function, 247-248
miracle criteria ranges, 249-250
simple criteria ranges, 246

dynamic array functions
FILTER function, 305-307, 363-364
RANDARRAY function, 304-305, 313
SEQUENCE function, 310-312
SORTBY function, 303-304
SORT function, 301-305
UNIQUE function, 309-310

engineering, 729-731
EOMONTH function, 183
EXACT function, 204
FILTER function, 305-307, 363-364
financial functions, 699-704
FIND function, 198-201
finding

in Formulas tab, 135
with Insert Function dialog box, 136

FLOOR function, 154
FLOOR.MATH function, 154
Formulas tab, 134

autocompleting functions, 135-136
finding functions, 135
Insert Function dialog box, 136

FORMULATEXT function, 232-234
FREQUENCY function, 577
GCD function, 159-160
GETPIVOTDATA function, 241-243
help

Excel Help, 139-140
Function Arguments dialog box, 137-139
On-Grid ToolTips, 137

HOUR function, 173
HSTACK function, 207
HYPERLINK function, 239
IFERROR function, 217-219
IF function, 211-217
IFNA function, 219
IFS function, 215-217
INDEX function, 158
INDIRECT function, 237-238
information functions, 732-733

CELL function, 223
ISFORMULA function, 219-220
IS functions, 220
NA function, 221-223
N function, 221

ISOMITTED function, 275

ISOWEEKNUM function, 179
LAMBDA function

array calculations, 270-273
array creation, 273-274
BYCOL function, 269
BYROW function, 269
column calculations, 269
helper functions, 12-13
hypotenuse of right triangles, 265-267
ISOMITTED function, 275
loops, 267-268
MAKEARRAY function, 273-274
MAP function, 270
optional arguments, 14
REDUCE function, 270-272
row calculations, 269
SCAN function, 270, 273
sharing between workbooks, 267-268
storing logic, 264-265
testing optional arguments, 275

LCM function, 160
LEFT function, 196
LEN function, 191, 198
LET function, 260-264
logical functions, 704-705

AND function, 213
CHOOSE function, 216-217
comparison operators, 212
IF function, 211-217
IFERROR function, 217-219
IFNA function, 219
IFS function, 215-217
NOT function, 217
OR function, 214
SWITCH function, 215-217

lookup and reference functions, 711-714
LOWER function, 188-189
MAKEARRAY function, 273-274
MAP function, 270
math functions

ABS function, 159
AGGREGATE function, 149-151
ARABIC function, 158
AVERAGEIFS function, 163-164
CEILING function, 154
CEILING.MATH function, 154
COUNT function, 152
COUNTA function, 152
COUNTIFS function, 163-164
FLOOR function, 154
FLOOR.MATH function, 154
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functions ���

GCD function, 159-160
INDEX function, 158
LCM function, 160
MAXIFS function, 163-164
MINIFS function, 163-164
MOD function, 160-162
MROUND function, 153
POWER function, 162
RAND function, 156
RANDARRAY function, 157
RANDBETWEEN function, 157
ROMAN function, 158
ROUND function, 153-154
ROUNDDOWN function, 153
ROUNDUP function, 153
SORTBY function, 157
SQRT function, 162-163
SUBTOTAL function, 155-156
SUM function, 140-142, 147-148. See also AutoSum
SUMIFS function, 163-165
trig functions, 714-718

MAXIFS function, 163-164
MID function, 197
MINIFS function, 163-164
MINUTE function, 173
MOD function, 160-162
MONTH function, 173
MROUND function, 153
N function, 221
#N/A errors, 134
NA function, 221-223
nested functions, Function Arguments dialog box, 139
NETWORKDAYS function, 184-186
new functions, 18-19
NOT function, 217
NOW function, 171-172
#NUM� errors, 134
OFFSET function, 234-237
OR function, 214, 247-248
parentheses ( ( ) ), 133
POWER function, 162
Power Query M functions, 760-763
PROPER function, 189
RAND function, 156
RANDARRAY function, 157, 304-305, 313
RANDBETWEEN function, 157
RANK.AVG function, 388
RANK.EQ function, 388
REDUCE function, 270-272
REPT function, 202-204
RIGHT function, 196

ROMAN function, 158
ROUND function, 153-154
ROUNDDOWN function, 153
ROUNDUP function, 153
SCAN function, 270, 273
SEARCH function, 200-202
SECOND function, 173
SEQUENCE function, 310-312
SLUGIFY function, 267
SORTBY function, 157, 303-304
SORT function, 301-305
SQRT function, 162-163
SQRTPI function, 162
statistical functions, 719-729
STOCKHISTORY function, 281
SUBSTITUTE function, 192, 202
SUBTOTAL function, 155-156
SUM function, 140-142, 147-148. See also AutoSum
SUMIFS function, 4, 163-165
SWITCH function, 215-217
syntax of, 133
testing with Fast Excel, 774-775
text functions

BASE function, 206-207
CHAR function, 192-195
CHOOSECOLS function, 208
CHOOSEROWS function, 208
CODE function, 195
EXACT function, 204
FIND function, 198-201
HSTACK function, 207
LEFT function, 196
LEN function, 191, 198
LOWER function, 188-189
MID function, 197
PROPER function, 189
REPT function, 202-204
RIGHT function, 196
SEARCH function, 200-202
SUBSTITUTE function, 192, 202
T function, 207
TEXT function, 204-205, 704-705
TEXTAFTER function, 207
TEXTBEFORE function, 207
TEXTJOIN function, 187-188
TEXTSPLIT function, 207
TOCOL function, 208
TOROW function, 208
TRIM function, 189-193
UNICHAR function, 192-195
UNICODE function, 195
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��� functions

UPPER function, 188-189
VALUE function, 207
VECTORWRAP function, 208
VLOOKUP function, 190, 218, 225-227, 260
VSTACK function, 207

TIME function, 175
TIMEVALUE function, 177-178
TOCOL function, 208
TODAY function, 171-172
TOROW function, 208
TRANSPOSE function, 240
TRIM function, 189-193
UDF function, 5
UNICHAR function, 192-195
UNICODE function, 195
UNIQUE function, 309-310
UPPER function, 188-189
#VALUE� errors, 134
VALUE function, 207
VBA user-defined function, 5
VECTORWRAP function, 208
VLOOKUP function, 190, 218, 225-227, 260
VSTACK function, 207
web functions, 734
WEEKDAY function, 178-179, 566
WEEKNUM function, 180
WORKDAY function, 183-185
XLOOKUP function, 225-227

matching lists, 230
returning cell references, 232
returning multiple values, 228-229
sideways searches, 229-230
twisted XLOOKUP, 230
two-way lookups, 230-231

XMATCH function, 230
YEAR function, 173
YEARFRAC function, 180

funneling chart data, ���
)u]]\ LooNup add�in, ��1

G
galleries, 22, ��
gaps in data, sparNlines, �2�
*&' function, 1���1��
generating

data diagrams with Visio Data Visualizer, 772
fake data, add-ins, 773-774

geographic data, filled map charts, ���
*eograph\ 'ata T\pe, ��
*etOpen)ileName, customi]ing macros, �������

*ET3,9OT'ATA function, 2�1�2��
*etSaveAs)ileName, customi]ing macros, �������
*oal SeeN, �������
greatest common denominators, *&' function, 1���1��
green bar formatting, 1�2
gridlines, printing, ���
grouping

daily dates, pivot tables, 381-382
dates

by day of the week, WEEKDAY function, 178-179
into weeks, ISOWEEKNUM function, 179
into weeks, WEEKNUM function, 180

sparklines, 610-612

H
hand�drawn shapes, 1�
+eader 	 )ooter tools 'esign tab, ribbon, ���, ��2����
headers�footers

adding pictures/watermarks, 663-664
automatic headers, 662
custom headers, 663
different headers/footers in same document, 664-665
scaling, 665

headings
names, adding multiple names from labels, 259
repeating on each page, 658

headlines, :ordArt, ��2����
heat maps, ���, ���
heights �rows�, formatting, �1���2�
help

functions
Excel Help, 139-140
Function Arguments dialog box, 137-139
On-Grid ToolTips, 137

VBA, 462
hidden content, finding with 'ocument ,nspector, ��
hiding icons in icon sets, ���
+ierarchical SmartArt, �2�����
+igh '3, displa\s, ��
highlighting

cells, 126
data, from specific days of the week, 566
extremes with color scales, 549-550
Greater Than, 557-559
Highlight Cells Rules, 556
rows

entire rows, 566-567
every other row, 567-568

histogram charts, freTuenc\ distribution, �������
historical stocN Tuotes, STO&.+,STORY function, 2�1
+ome screen, navigating, �2

www.itbook.store

https://itbook.store


justifying text in ranges ���

+ome tab, formatting numbers, �������
+OUR function, 1��
+STA&. function, 2��
h\perlinNs

adding with HYPERLINK function, 239
storing, 58

h\potenuse of right triangles, LAM%'A function, 2���2��

I
icons, �2�, �������

Cut-out People, 14-15
QAT

adding icons to QAT, 27
removing icons from QAT, 28
resequencing icons in QAT, 29
separating icons in QAT, 29

ribbon, selecting icons, 64-65
sorting data by, 43
whitespace, adding, 35

icon sets
hiding icons, 554
mixing icons, 554
moving numbers closer to icons, 552-553
segregating data, 550-551
setting up, 551-552

,) function, 211�21�
,f�End ,f constructs, macro Áow control, ��1���2
,)ERROR function, 21��21�
,)NA function, 21�
,)S function, 21��21�
ignoring

error cells, 149-151
filtered rows, 149-151

illustrations, �2�, �������
images

adding to SmartArt, 628
transparency, 15-16

implicit intersections, ��, 1�2, 111�112, 12�
in�cell bar charts, �������
incompatible formulas, ��
,N'E; function, 1��
indexing with SUM,)S function, �
,N',RE&T function, 2���2��
individual characters, formatting, ��1���2
information functions, ��2����

CELL functions, 223
IS functions, 220
ISFORMULA function, 219-220
N function, 221
NA functions, 221-223

initial saves, sharing worNbooNs during, ���
inNing tools, �������
,nTuire, ��1 �������
,nsert )unction dialog box, finding functions, 1��
inserting

3D Models, 491-492
columns, Filtered Data, 4
Cut-out People, 647-648
icons, 647-648
illustrations, 647-648
pictures

Bing Images, 637
Clip Art, 636-637
from your computer, 635
into Excel, 635
multiple pictures at once, 635
Stock Images, 636-637

SmartArt, 626-627
stickers, 647-648
symbols into cells, 487

,nsights �Smart LooNup�, �������
intermediate formula results, storing with LET function, 

2���2��
international text comparisons, �
invoice registers, formatting, �������
,S functions, 22�
,S)ORMULA function, 21��22�
,SOM,TTE' function, 2��
,SO:EE.NUM function, 1��
italic text, �1���1�

J
Moining

criteria with DSUM function
AND function, 247
OR function, 247-248

tables with Power Pivot (Data Model), 410-411
text

ampersand operator (&), 121
dates/time, 121-122
TEXTJOIN function, 121, 187-188

with numbers, 121-122
Mumping

to bottom of data, 77
to next corner of selections, 78

Mustif\ing text in ranges, �������
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��� keyboards

K
Ne\boards

accelerators
backing up one level in menus, 66
confusion, 66-68
Excel 2003 accelerators, 79-80
Excel 2003 Alt shortcuts, 80-81
KeyTips, 63-64
navigating drop-down menu lists, 66
selecting dialog boxes, 68
selecting gallery options, 65
selecting icons on ribbon, 64-65

legacy commands, 81-89
shortcuts, 68

accessing Slicers, 66
adding dollar signs ($) to references, 79
calculating data, 73-77
choosing slicer items, 79
crossing tasks off lists, 78
Ctrl shortcut keys, 69
data entry, 73-77
date/time stamps, 78
extending selections, 72-73
F6 loops, 66
formatting data, 73-77
jumping to bottom of data, 77
jumping to next corner of selections, 78
moving between worksheets, 77
navigation shortcut keys, 70-71
opening right-click menus, 78
repeating last task, 78
selecting cells, 71-72
selecting current ranges, 77
selecting data, 71-73

Ne\ combinations
Ctrl+Backspace key combination, bringing active cells back 

into view, 489
Ctrl+click key combination, unselecting cells, 39-40
Ctrl+Down-Arrow key combination, handling variable 

numbers of rows, 455-456
Ctrl+Enter key combination, copying formulas, 106
Ctrl+T key combination (Table tool), copying formulas, 

108-109
Ctrl+Up-Arrow key combination, finding last records, 455

.e\Tips, �����

L
Label )ilter Á\�out, filtering pivot tables, �������
labels

3D Maps, 602
multiple names, adding from labels, 259
sparklines, 618-620

LAM%'A function
array calculations, 270

returning intermediate values, 273
returning single values, 271-272

arrays, creating, 273-274
BYCOL function, 269
BYROW function, 269
column calculations, 269
helper functions, 12-13
hypotenuse of right triangles, 265-267
ISOMITTED function, 275
loops, 267-268
MAKEARRAY function, 273-274
MAP function, 270
optional arguments, 14, 275
REDUCE function, 270-272
row calculations, 269
SCAN function, 270, 273
sharing between workbooks, 267-268
storing logic, 264, 265

landscape orientation, printing, ���
largest customers, sorting collapsed subtotal view, ��2����
last command, repeating, ���
last records, finding with &trl�Up�Arrow Ne\, ���
last rows with data, finding, �������
last tasN, repeating, ��
la\ers ��' Maps�, combining, ���
L&M function, 1��
leading�trailing spaces �text�, removing

LEN function, 191
TRIM function, 189-193
VLOOKUP function, 190

leading ]eroes, adding to numbers with %ASE function, 
2���2��

least common multiples, L&M function, 1��
LE)T function, 1��
legac\ comments. See Notes
legac\ dialog boxes, selecting, ��
legac\ Ne\board commands, �1���
LEN function, 1�1, 1��
LET function, 2���2��
lightning bolt drop�down menu, 1��
line charts, sparNlines, ���
lines, animating between points in �' Maps, ��1
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macros ���

linNs
creating

mouse, 289-290
Paste Options menu, 286-287
right-drag menu, 287-289
to unsaved workbooks, 291
with formulas, 291

external workbook links, absolute references, 290
Links tab, Trust Center, 292-293
missing workbook links, 293
opening closed workbooks, 293
Update Links dialog box, preventing from appearing, 

294-295
updating, 293-294

lists
crossing tasks off, 78
matching, 230

loading data, 3ower 4uer\, �2�����
single workbook, 323-324
sources, 322

load times, �
locating

arrays, data types, 278-279
cells

with data from past 30 days, 565-566
within three days of today, 565

characters in text cells
with FIND function, 198-201
with SEARCH function, 200-202

Find dialog box, showing all options, 8
FIND function, locating characters in text cells, 198-201
functions

in Formulas tab, 135
with Insert Function dialog box, 136

hidden content with Document Inspector, 34
last rows with data, 468-469
lost ribbon commands, 25-26
near matches with Fuzzy Lookup, 771
number of characters in text cells with LEN function, 198
printing settings, 652-653
shared

documents, 680
workbooks, 679

logic, storing with LAM%'A function, 2���2��
logical functions, �������

AND function, 213
CHOOSE function, 216-217
comparison operators, 212
IFERROR function, 217-219
IF function, 211-213

nesting, 214-217

IFNA function, 219
IFS function, 215-217
NOT function, 217
OR function, 214
SWITCH function, 215-217

long text passages, Áowing into ranges, �������
looNup�reference functions, �11��1�

CHOOSE function, 224
FORMULATEXT function, 232-234
GETPIVOTDATA function, 241-243
HYPERLINK function, 239
INDIRECT function, 237-238
OFFSET function, 234-237
TRANSPOSE function, 240
XLOOKUP function, 225-227

matching lists, 230
returning cell references, 232
returning multiple values, 228-229
sideways searches, 229-230
twisted XLOOKUP, 230
two-way lookups, 230-231

XMATCH function, matching lists, 230
looNups

simple lookups, CHOOSE function, 224
two-way lookups, XLOOKUP function, 230-231

loops
deleting records, 474-476
F6 loops, 66
FinalRow, combining with, 471
LAMBDA function, 267-268
rows, 469
testing records, 473-474

lost ribbon commands, finding, 2��2�
lowercase text, sorting data, ��
LO:ER function, 1���1��

M
macros

advanced filters for unique records, 479-481
AutoFilter, 481-482
cells, selecting, 482-483
customer reports, creating, 477-484
customizing, 467-468
debugging, 476
disabling notifications, 446
editing, 457
everyday-use macros, customizing, 467-468
flow control

If-End If constructs, 471-472
Select Case constructs, 472-473

formatting, mail merges, 447-449
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��� macros

GetOpenFileName, 467-468
GetSaveAsFileName, 467-468
If-End If constructs, 471-472
invoice register example, 454-456
loops

deleting records, 474-476
testing records, 473-474
with FinalRow, 471

macro recorder
default state, 449-450
parameters, 461-462
starting, 451-452

mail merges, 447-449
notifications, disabling, 446
R1C1-style formulas, 464-465
range references, 470
recording, 446-447

in blank workbooks, 455-456
macro recorder, default state, 449-450
macro recorder, parameters, 461-462
macro recorder, starting, 451-452
Relative References, 450

rows
finding last rows with data, 468-469
looping through rows, 469

running, 453-454
security, 446
Select Case constructs, 472-473
slow motion, running in, 476-477
spillable formulas, 466
troubleshooting, 477
variables, 463-464
VBA

macros, 5
security, 446

magnitude of error, determining with A%S function, 1��
mail merges, formatting macros, �������
MA.EARRAY function, 2���2��
managing worNbooN access, �������
Manual &alculation mode, pivot tables, ���
manual page breaNs, ������1
MA3 function, 2��
mapping

3D Maps, 587
alternate maps, 603
animating lines between points, 601
animating over time, 591
color, 589
column charts, 588
combining layers, 599
custom maps, 604-605

data entry, 594-597
Flat Map option, 600
heat maps, 588
labels, 602
photos, 598-600
resizing columns, 599
resizing panes, 600
rotating, 598
satellite photos, 600
shaded area maps, 587
store maps, 603
time choices, 601
tipping, 598
tours, 603
world maps, 600
zooming in/out, 589-594, 598

data to sparklines, 608-609
geographic data with filled map charts, 580

margins �worNsheets�, changing, ���
matching

lists, 230
near matches, finding with Fuzzy Lookup, 771

mathematical operators, formulas, 11��11�
mathematical transformations, )lash )ill, �1
math functions

ABS function, 159
AGGREGATE function, 149-151
ARABIC function, 158
AVERAGEIFS function, 163-164
CEILING function, 154
CEILING.MATH function, 154
COUNTA function, 152
COUNT function, 152
COUNTIFS function, 163-164
FLOOR function, 154
FLOOR.MATH function, 154
GCD function, 159-160
INDEX function, 158
LCM function, 160
MAXIFS function, 163-164
MINIFS function, 163-164
MOD function, 160-162
MROUND function, 153
POWER function, 162
RANDARRAY function, 157
RANDBETWEEN function, 157
RAND function, 156
ROMAN function, 158
ROUNDDOWN function, 153
ROUND function, 153-154
ROUNDUP function, 153
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notifications ���

SORTBY function, 157
SQRT function, 162-163
SUBTOTAL function

multiple levels of totals, 155
totaling visible cells, 156

SUM function, 140-142, 147-148. See also AutoSum
SUMIFS function, 163-165
trig functions, 714-718

MA;,)S function, 1���1��
medians �pivot tables�, creating with 'A; measures, 

�1���21
menus

backing up one level, 66
lightning bolt drop-down menus, 109
right-click menus, opening, 78

merging
cells, 4, 520-523
workbooks, 438

methods, 9%A, ���
Microsoft ��� Excel, improvements to performance, �
M,' function, 1��
M,N,)S function, 1���1��
mini toolbar, formatting selected text, ��
M,NUTE function, 1��
miracle criteria ranges, 'SUM function, 2���2��
missing

data
not plotting in charts, 221-223
sparklines, 620

linked workbooks, 293
mixing

icons in icon sets, 554
references, 98-99

MO' function, 1���1�2
monitors, two�monitor setups, ��
Monte &arlo anal\sis, ���
MONT+ function, 1��
months

daily dates, subtotaling by months, 348
pivot table summaries, 381-382

More commands, 22�2�
mouse linNs, creating, 2���2��
mouse method, formula entr\, 1��
moving

between worksheets, 77
numbers closer to icons in icon sets, 552-553

MROUN' function, 1��
multiple fields, subtotaling, ���
multiple names, adding at once, 2��
multiple pictures, inserting into Excel at once, ���
multiple sets of parentheses � � � �, 11��11�

multiple tasN panes, opening at once, 11
multiple values, returning with ;LOO.U3 function, 

22��22�
multiple worNsheets, unhiding, �
multiplication�division operations, order in formulas, 11�

N
N function, 221
NA function, 221�22�
Name dialog box, navigating cells with, 2��
names

absolute references, avoiding, 260
adding multiple names at once, 259
assigning, 254
formulas

applying retroactively, 258-259
simplifying with named ranges, 257-258

headings, adding multiple names from labels, 259
labels, adding multiple names from labels, 259
navigating with Name dialog box, 255
ranges, simplifying formulas, 257-258
retroactively applying to formulas, 258-259
workbook-level names, 256-257
worksheets, returning names with CELL function, 223

navigating
Backstage view, File menu, 31
bottom of data, jumping to, 77
cells by name with Name dialog box, 255
drop-down menu lists, 66
Home screen, 32
menus, backing up one level, 66
ranges by name with Name dialog box, 255
ribbon, 22
shortcut keys, 70-71
worksheets, 35

navigation pane, Accessibilit\ &hecNer, 11�12
near matches, finding with )u]]\ LooNup, ��1
nested functions

Function Arguments dialog box, 139
IF function, 214-217

NET:OR.'AYS function, 1���1��
new functions, 1��1�
next corner of selection, Mumping to, ��
Normal view, ��
NOT function, 21�
notes

in cells, 535-538
sharing workbooks, 689

notifications
disabling macros, 446
sharing workbooks, 678-680
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��� nouns

nouns
object.method as, 459
plural noun comparisons to collections, 459

NO: function, 1�1�1�2
numbers

adding
AutoSum, 140-144
SUM function, 147-148
with status bar, 38-39

Arabic numbers, ARABIC function, 158
as criteria, DSUM function, 248
calculating, 163-165
converting to text, VALUE function, 207
currency, displaying, 506
dates/time, 165

comparing, conditional formatting, 559-560
custom numeric formatting, 512-513
DATEDIF function, 180-182
DATE function, 173-175
DATEVALUE function, 176-177
DAY function, 173
DAYS function, 183
displaying, 507
EOMONTH function, 183
formatting, 168-170
HOUR function, 173
ISOWEEKNUM function, 179
MINUTE function, 173
MONTH function, 173
NETWORKDAYS function, 184-186
NOW function, 171-172
potential problems, 166-167
SECOND function, 173
TIME function, 175
TIMEVALUE function, 177-178
TODAY function, 171-172
troubleshooting, 166-167
WEEKDAY function, 178-179
WEEKNUM function, 180
WORKDAY function, 183-185
YEAR function, 173
YEARFRAC function, 180

exponents, calculating with POWER function, 162
filling in Flash Fill, 41
filters, 358-359
formatting

as text with TEXT function, 204-205
currency, 506
custom formats, 509-513
dates, 507
fractions, 507

leading zeroes, adding with BASE function, 206-207
phone numbers, 508
Social Security numbers, 509
times, 507
with Format Cells dialog box, 505
with Home tab, 503-505
with thousands separators, 506
ZIP Codes, 508-509

fractions, displaying, 507
greatest common denominators, GCD function, 159-160
joining text with, 121-122
least common multiples, LCM function, 160
magnitude of error, determining with ABS function, 159
moving closer to icons in icon sets, 552-553
page numbers, 656, 670
phone numbers, displaying, 508
pivot tables, formatting numeric fields, 378-379
random numbers

choosing with INDEX function, 158
generating arrays with, 313
generating, RANDARRAY function, 157
generating, RANDBETWEEN function, 157
generating, RAND function, 156
sorting with SORTBY function, 157

range descriptions, OFFSET function, 234-237
remainders of division problems, finding with MOD 

function, 160-162
Roman numbers, ROMAN function, 158
rounding

CEILING function, 154
CEILING.MATH function, 154
FLOOR function, 154
FLOOR.MATH function, 154
MROUND function, 153
ROUNDDOWN function, 153
ROUND function, 153-154
ROUNDUP function, 153

scientific notation, displaying, 513
sequences generating, 310-312
Social Security numbers, displaying, 509
square roots, calculating with SQRT function, 162-163
time/dates, 165

custom numeric formatting, 512-513
DATE function, 173-175
DATEDIF function, 180-182
DATEVALUE function, 176-177
DAY function, 173
DAYS function, 183
displaying, 507
EOMONTH function, 183
formatting, 168-170

www.itbook.store

https://itbook.store


.PDF ��1

HOUR function, 173
ISOWEEKNUM function, 179
MINUTE function, 173
MONTH function, 173
NETWORKDAYS function, 184-186
NOW function, 171-172
potential problems, 166-167
SECOND function, 173
TIME function, 175
TIMEVALUE function, 177, 178
TODAY function, 171-172
troubleshooting, 166-167
WEEKDAY function, 178-179
WEEKNUM function, 180
WORKDAY function, 183-185
YEAR function, 173
YEARFRAC function, 180

totaling with SUBTOTAL function
multiple levels of totals, 155
visible cells, 156

ZIP Codes, displaying, 508-509

O
obMect.method, 9%A, ���
obMects

saving as pictures, 16
VBA, 459

obMect variables, 9%A, �������
Office Add�,ns store, ���
Office themes, �2���2�
O))SET function, 2���2��
one�clicN printing, ��1���2
one�clicN sorting, ��
One'rive, storing worNbooNs, ���
one�page summaries, showing with subtotals, ��2
On�*rid ToolTips, functions, 1��
Online 3ictures, �2�

arranging, 645-647
Artistic Effects, 642
Aspect Ratio, 638
brightness, 639-640
contrast, 639-640
cropping, 639
file sizes, 644
formatting with ribbon tab, 637
inserting into Excel, 636-637
Picture Styles gallery, 640-642
removing backgrounds, 642-643
resizing, 637
rounded corners, 639
selecting, 645-647

sharpness, 639-640
transparency, 640

opening
Backstage view, File menu, 30
file extensions, 56
File menu, full screen, 30
multiple task panes at once, 11
recent files, 58
right-click menus, 78
workbooks

searching while opening, 8
UDF, 4

operators
comparison operators, 212
formula operators, 115-116

optional arguments, LAM%'A functions, 1�
order of operations, formulas, 11��11�
OR function, 21�, 2���2��
organi]ational charts, �2�����
orientation, printing, ���
original text, returning edited text to with T function, 2��
overriding order of operations with parentheses � � � �, 11�

P
page breaNs, ��1

automatic page breaks, 660
manual page breaks, 660
Page Break Preview, 39, 654

3age La\out tab, ribbon, ��2, ���
3age La\out view, ��, ��2, ���, ��2����, �������
page numbers, ���, ���
3age Setup dialog box, ��2, ���, ���
paintbrush icon, charts, �������
panes ��' Maps�, resi]ing, ���
parameters, 9%A, ������2
parentheses � � � �

functions, 133
multiple sets of, 117-118
overriding order of operations, 116
stacking, 117-118

3areto charts, ���
parts of formulas, evaluating, 1��
parts of worNsheets, excluding from printing, ���
past �� da\s, finding cells with data, �������
3aste Options menu, creating linNs, 2���2��
pasting

conditional formatting, 539
formulas, 538-539
from clipboard, 4
new data to charts, 580-583

.3'), worNsheets as, ��1
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��2 People Graph

3eople *raph, ���
percentages of totals, showing in pivot tables, �������
performance

load times, 3
Microsoft 365 Excel improvements, 4
ribbon, 14
stock data, 5-6
VBA Editor, 5

phone numbers, displa\ing, ���
pictures, �2�

3D Maps, 598-600
adding to headers, 663-664
arranging, 645-647
Artistic Effects, 642
Aspect Ratio, 638
backgrounds, 642-643
brightness, 639-640
contrast, 639-640
cropping, 639
file sizes, 644
formatting with ribbon tab, 637
inserting

Bing Images, 637
Clip Art, 636-637
from your computer, 635
into Excel, 635
multiple pictures at once, 635
Stock Images, 636-637

Picture Styles gallery, 640-642
removing backgrounds, 642-643
resizing, 637
rounded corners, 639
saving objects as, 16
Screen Clippings, 645
selecting, 645-647
sharpness, 639-640
transparency, 640

pie charts, small pie slices, �������
pivot tables

adding
fields, 373-374
outside calculations, 382-383

artificial intelligence as inspiration, 371-373
blank pivot tables, 373
blank rows, 380
blanks, removing, 378-379
building, Power Pivot (Data Model), 413
calculations, 381

adding outside calculations, 382-383
changing field calculations, 383-385

changing
cells, 380
reports by field lists, 374-376

collapsible task panes, 10
conditional formatting, 570-571
converting to dashboard formulas, 423-424
copying for each customer, 407
counting distinct, 414-416
creating, 373-374
customizing, 374-376
data views, 369
development of, 369-370
drop zones, 377-378
fields

adding, 373-374
changing calculations, 383-385

filtering
AutoFiltering, 405-407
check boxes, 395-396
clearing, 395
Date Filters fly-out, 397
dates, 405
including filtered items in totals, 416-418
Label Filter fly-out, 396-397
row label filter, 393-395
slicers, 399-404
Top 10 Filter dialog box, 398-399

formatting
cells, 379
numeric fields, 378-379

Manual Calculation mode, 380
medians, creating with DAX measures, 418-421
missing tools, recovering, 380
months, 381-382
percentages of totals, showing, 385-386
quarters, 381-382
rankings, 386-387
refreshing, 380
replicating for each customer, 407
retrieving cells, GETPIVOTDATA function, 241-243
roll-ups, 381-382
row label filter, 393-395
running totals, showing, 386-387
showing

percentages of totals, 385-386
running totals, 386-387
tools, 380

slicers, filtering with
adding slicers, 399-400
arranging slicers, 400-401
using slicers, 401-404
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Quick Print ���

sorting, 407
summarizing, daily dates into months, quarters, years, 

381-382
troubleshooting, 25, 380
viewing changes, 380
years, 381-382

plural nouns, comparing to collections, ���
plus icon, charts, ���
3MT function, �2�����
3O:ER function, 1�2
3ower 3ivot �'ata Model�, ���, ���

additional information, 426
benefits of, 426
Diagram view, 412
hidden features, unlocking, 414
joining multiple tables, 410-411
limitations/workarounds, 424-426
pivot tables

building, 413
converting to formulas, 423-424
counting distinct, 414-416
creating medians with DAX measures, 418-421
including filtered items in totals, 416-418
time intelligence, DAX measures, 421-423

relationships between tables, creating, 411-412
3ower 4uer\, �21

columns, adding, 328
custom data types, creating, 335-337
functions, 760-763
loading data, 329-330

single workbook, 323-324
sources, 322

profiling data, 334
refreshing data, 330
reviewing queries, 328-329
splitting delimiters in new rows, 330-331
transforming data, 324-326
unpivoting data, 326-327
workflows, establishing, 322
worksheets, appending

one worksheet from every workbook in folder, 331-332
one worksheet from one workbook, 332-333

presence, collaboration, ������1
previous versions, rolling bacN with 9ersion +istor\, ��2, 

���
printing

as .PDF, 671
centering reports on page, 669-670
changing

Page Setup settings, 668
printer properties, 668

choosing
printers, 666
what to print, 667

comments, 670
Excel Options, 654
excluding parts of worksheets from printing, 659
finding settings, 652, 653
gridlines, 669
Header & Footer tools Design tab, ribbon, 653, 662-665
headings, repeating on each page, 658
margins, 657
one-click printing, 651-652
orientation, 657
Page Break Preview, 654, 661
Page Layout tab, ribbon, 652, 657
Page Layout view, 652, 657, 662-665, 668-669
page numbers, 656, 670
Page Setup dialog box, 652, 657, 668
paper size, 657
Printer Properties dialog box, 654
Print panel, File menu, 652, 666-667
Print Preview Full Screen, 654-656
Print Preview, Print panel, 654-656
Print What gallery, 667
Quick Print, 651-652
replacing error values, 670
scaling data to fit pages, 660

profiling data with 3ower 4uer\, ���
3roMect pane, 9%E, ���
3RO3ER function, 1��
properties

Properties pane, VBE, 457
VBA, 462

protecting worNsheets, �������

Q
4AT �4uicN Access Toolbar�

adding icons, 27
customizing, 28-29
KeyTips, 63-64
mouse method, formula entry, 104
Quick Print, 651-652
removing icons, 28
resequencing icons, 29
separating icons, 29

Tuarters, pivot table summaries, ��1���2
Tueries, reviewing with 3ower 4uer\, �2���2�
4uicN Access Toolbar, 1�
TuicN formatting, ��2����
4uicN 3rint, ��1���2
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��� R1C1-style formulas

R
R1&1�st\le formulas, macros, �������
RAN'ARRAY function, �������, �1�
random numbers, generating arra\s, �1�
random numbers�data

choosing with INDEX function, 158
generating

RANDARRAY function, 157
RANDBETWEEN function, 157
RAND function, 156

sorting with SORTBY function, 157
ranges

criteria ranges, DSUM function
miracle ranges, 249, 250
returning all records with blank ranges, 246
simple ranges, 246

current ranges, selecting, 77
defining as tables, 108
deleting ranges with merged cells, 4
describing with numbers, OFFSET function, 234-237
flowing long text passages in, 633-634
justifying text, 534-535
names, 253

navigating with Name dialog box, 255
simplifying formulas, 257-258
workbook-level names, 256-257

references, macros, 470
Spilled Range Operator (#), 112, 313

ranNings, pivot tables, �������
reappl\ing filters, ���
recent files, opening, ��
Recent :orNbooNs list, clearing, �2
Recommended &harts, choosing from, �������
recording macros, �������

in blank workbooks, 455-456
macro recorder

default state, 449-450
parameters, 461-462
starting, 451-452

Relative References, 450
records

AutoFilter, 481, 482
conditionally sum records, DSUM function, 245-246
filtering

advanced filter, 360-367
clearing filters, 353
columns with applied filters, 352
combining filters, 352
copying results, 360
dates, 357-359

features of, 349
Filter by Color, 356-357
Filter by Selection, 353-356
formatting results, 360
numbers, 358-359
reapplying filters, 353
refreshing filters, 353
resizing drop-down menu, 353
selecting multiple items, 351-352
text, 358-359
totaling results, 360
using, 349, 350

loop records
deleting, 474-476
testing, 473-474

returning with blank criteria ranges, 246
summing, DSUM function, 245-246
unique records, advanced filters, 479-481

recovering unsaved worNbooNs, �2
rectangular ranges, )� Ne\, 1�1�1�2
RE'U&E function, 2���2�2
reference functions

CHOOSE function, 224
FORMULATEXT function, 232-234
GETPIVOTDATA function, 241-243
HYPERLINK function, 239
INDIRECT function, 237-238
OFFSET function, 234-237
TRANSPOSE function, 240
XLOOKUP function, 225-227

matching lists, 230
returning cell references, 232
returning multiple values, 228-229
sideways searches, 229-230
twisted XLOOKUP, 230
two-way lookups, 230-231

XMATCH function, matching lists, 230
references

absolute references ($$), 96-98
avoiding with names, 260
external workbook links, 290

arrays
entire arrays, 313
Spilled Range Operator (#), 112, 313

cells
building/evaluating with INDIRECT function, 237-238
returning with LOOKUP function, 232

dollar signs ($)
adding to references, 79
absolute references ($$), 96-98, 260, 290

www.itbook.store

https://itbook.store


ribbon ���

lookup and reference functions, 711-714
workbook-level names, 257

refreshing
data, Power Query, 330
filters, 353
pivot tables, 380
stock data, 5, 6

relationships, tables, �11��12
relative references, 122�12�

formulas, 96
recording macros, 447, 450

remainders of division problems, finding with MO' 
function, 1���1�2

reminders �&S9 files�, turning on�off, �����
remote worNing. See collaboration
removing

backgrounds from pictures, 642-643
blanks from pivot tables, 378-379
duplicates from filtered results, 364-365
icons from QAT, 28
leading/trailing spaces (text)

LEN function, 191
TRIM function, 189-193
VLOOKUP function, 190

manual page breaks, 661
page breaks, 661
subtotals, 346

reordering columns, sorting data, ��
repeating

columns, 658
headings on each page, 658
last command, 489
last tasks, 78
rows, 658
text with REPT function, 202-204

replacing
error values when printing, 670
text characters with SUBSTITUTE function, 202

replicating pivot tables for each customer, ���
reports

customer reports, creating, 477-484
excluding parts of reports from printing, 659
headers/footers

adding pictures/watermarks, 663-664
automatic headers, 662
custom headers, 663
different headers/footers in same document, 664-665
scaling, 665

headings, repeating on each page, 658
margins, 657
orientation, 657

page breaks, 660-661
pivot table reports, changing with field lists, 374-376
printing

as PDF, 671
centering reports on page, 669-670
changing Page Setup settings, 668
changing printer properties, 668
choosing printers, 666
comments, 670
controlling first page numbers, 670
gridlines, 669
page numbers, 656
paper size, 657
previewing, 654-656
Print panel, File menu, 666
replacing error values, 670
what to print, 667

saving as PDF, 671
scaling data to fit pages, 660
Scenario Summary reports, 438

RE3T function, 2�2�2��
reseTuencing icons in 4AT, 2�
resi]ing

columns, 3D Maps, 599
Excel, ribbon changes, 24
Filter drop-down menu, 353
formula bar, 36-37
panes, 3D Maps, 600
pictures, 637

results of distant cells, watching, �������
retrieving cells from pivot tables with *ET3,9OT'ATA 

function, 2�1�2��
retroactivel\ appl\ing names to formulas, 2���2��
returning

arrays, data types, 277
cell references with XLOOKUP function, 232
intermediate values in arrays with REDUCE function, 273
multiple values with XLOOKUP function, 228-229
records with blank criteria ranges, 246
single values in arrays with REDUCE function, 271-272
to original text with T function, 207

reusing theme effects, ���
reviewing Tueries with 3ower 4uer\, �2���2�
ribbon

Accessibility Checker, 11-12
changes from resizing Excel, 24
contextual tabs, 25
Developer tab, 24
dialog box launcher, 22-23
finding lost commands, 25-26
fly-out menus, 22
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��� ribbon

formatting pictures, 637
galleries, 22
Header & Footer tools Design tab, 653, 662-665
icons, selecting, 64-65
navigating, 22
Page Layout tab, 652, 657
performance, 14
rounded edges, 14
scrolling through tabs, 22
shrinking, 26
sizing, 26
task panes, 22-23
updates, 21
VBA tools, 24

right�clicN menus, opening, ��
right�drag menu

formulas, converting to values, 289
links, creating, 287-289

R,*+T function, 1��
right triangles, h\potenuse of, 2���2��
rolling bacN changes, 9ersion +istor\, ��2����
roll�ups, pivot tables, ��1���2
ROMAN function, 1��
rotating

3D Maps, 598
3D Models, 492
text, 523-524

rounded corners, pictures, ���
rounded edges, ribbon, 1�
rounding numbers, 1���1��
row input cells, ��1
rows

2D arrays, 208
blank rows, pivot tables, 380
CHOOSEROWS function, 208
delimiters, splitting in new rows, 330-331
filtered rows, ignoring with AGGREGATE function, 149-151
FinalRow, loops, 471
heights, formatting, 519-520
highlighting

entire rows, 566-567
every other row, 567-568

LAMBDA function calculations, 269
last rows with data, finding, 468-469
loops, 469
pivot tables, row label filter, 393-395
repeating, 658
row label filter, pivot tables, 393-395
subtotal rows

copying only, 344-345
formatting, 345-346

TOROW function, 208
variable number of rows, handling with Ctrl+Down-Arrow 

key combination, 455
VECTORWRAP function, 208

rules
advanced formatting, 562, 563
conditional formatting, rules based on formulas, 564-565
formatting rules, combining, 568-569
Highlight Cells Rules, 556
Text That Contains formatting rule, 561-562
top/bottom rules, conditional formatting, 554-555

running
macros, 453-454
totals, showing in pivot tables, 386-377

S
satellite photos, �' Maps, ���
Save As, browsing during, �
saving

AutoSave, 694
chart styles as templates, 584-585
objects as pictures, 16
themes, 530
workbooks, sharing during initial saves, 675
worksheets as PDF, 671

scaling
data to fit pages, printing, 660
headers/footers, 665
sparklines, 610

S&AN function, 2��, 2��
Scenario Manager

comparing results, 435
loading values, 435
multiple scenarios, adding, 438
Scenario Summary reports, 438
Scenario Values dialog box, 437
setting up scenarios, 436-437
using, 435-437
workbooks, merging, 438

Scenario Summar\ reports, ���
science proMects, 'ata Streamer, ��2
scientific notation, displa\ing, �1�
Screen &lippings, ���
scrolling tabs in ribbon, 22
searches

Bing Images, 637
from title bar, 56
SEARCH function, locating characters in text cells, 200-202
sideways searches, XLOOKUP function, 229-230
Stock Images, 636
workbooks, while opening, 8
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sizing ���

SE&ON' function, 1��
securit\, macros, ���
seeing

all formulas, 126
direct precedents, 126-127

segregating data, icon sets, ������1
Select &ase constructs, macro Áow control, ��2����
selecting

cells
shortcut keys, 71-72
with macros, 482-483

current ranges, 77
data

extending selections shortcut keys, 72-73
shortcut keys, 71-72

dialog boxes, 68
Filter by Selection, 353-356
gallery options, 65
icons on ribbon, 64-65
legacy dialog boxes, 68
multiple Filter items, 351-352
next corner of selections, jumping, 78
pictures, 645-647
subsets of columns with FILTER function, 307

sentiment anal\sis, A]ure Machine Learning, ��2
separating

icons from QAT, 29
text with delimiters, 489-490

seTuences
numbered sequences, generating, 310-312
SEQUENCE function, 310-312
unique sequences, sorting data, 45

setting expiration dates when sharing worNbooNs, �������
setting up icon sets, ��1���2
shaded area maps, ���
shapes, �2�

choosing styles, 632
displaying cell contents, 630-632
hand-drawn, 18

sharing
LAMBDA function between workbooks, 267-268
themes, 531
workbooks

comments, 677, 687, 692
during initial saves, 675
expiration dates, 676-677
finding shared workbooks, 679-680
#Mentions, 677, 687, 692
Notes, 689
notifications, 678-680
threaded comments, 688-689

tracking changes, Catch Up button, 692
tracking changes, Show Changes, 690
tracking changes, Version History, 690-693
with Share button, 676

sharpness, pictures, �������
Sheet 9iews, filtering�sorting data, �������
shortcuts, Ne\board, ��

calculating data, 73-77
choosing slicer items, 79
crossing tasks off lists, 78
Ctrl shortcut keys, 69
data entry, 73-77
date/time stamps, 78
dollar signs ($), adding to references, 79
extending selections, 72-73
F6 loops, 66
formatting data, 73-77
jumping

to bottom of data, 77
to next corner of selections, 78

moving between worksheets, 77
navigation shortcut keys, 70-71
opening right-click menus, 78
repeating last task, 78
selecting

cells, 71-72
current ranges, 77
data, 71-73

slicers, accessing, 66
Show &hanges, �, ���
Show )ormulas mode, 12�
showing

access to workbooks, 677-678
all options in Find dialog box, 8
data bars for subsets of cells, 548
financial data, waterfall charts, 579
pivot tables

running totals, 386-387
tools, 380

sparkline details, 618-620
subtotals, one-page summaries, 342

shrinNing ribbon, 2�
side b\ side view, worNsheets, 2���2��
sidewa\s searches, ;LOO.U3 function, 22��2��
simple criteria ranges, 'SUM function, 2��
simple looNups, &+OOSE function, 22�
simple variables, 9%A, �������
simplif\ing formulas, named ranges, 2���2��
si]ing

columns, 3D Maps, 599
panes, 3D Maps, 600
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��� sizing

paper, printing, 657
pictures, 637
ribbon, 26

slicers
accessing, 66
choosing items from, 79
pivot tables

adding slicers, 399-400
arranging slicers, 400-401
using slicers, 401-404

slow motion
formulas

calculations, 486-487
evaluating, 129

running macros in, 476
SLU*,)Y function, 2��
small pie slices, pie charts, �������
small reports, centering on page, �������
SmartArt, �2�

adding images, 628
changing existing SmartArt to new styles, 627
common elements, 625
Hierarchical SmartArt, 629-630
inserting, 626-627
organizational charts, 629-630
styles, 624-625

Smart LooNup �,nsights�, ���
smooth scrolling cells, �
Social Securit\ numbers, displa\ing, ���
Solver, ���, ���

installing, 441
Monte Carlo analysis, 444
premium versions, 443
solving models, 441-443
using, 441-443

SORT function, ��1����
SORT%Y function, �������
sorting

collapsed subtotal view with largest customers at top, 
342-343

data
AZ/ZA buttons, 43
by color, 43
by icons, 43
case-sensitive text, 44
custom lists, 45
lowercase/uppercase text, 44
one-click sorting, 46
reordering columns, 44
troubleshooting, 46-47

unique sequences, 45
workbook data, Sheet Views, 683-686

formulas, 301-305
pivot tables, 407

spaces
custom numeric formatting, 511
text, removing trailing spaces
with LEN function, 191
with TRIM function, 189-193
with VLOOKUP function, 190

sparNlines
axis values, 614-615
built-in choices, 612-614
color, 614
column charts, 607, 617
copying, 620
creating, 608-612
customizing, 612-614
enlarging, 618-620
gaps in data, 620
groups, 610-612
labels, 618-620
line charts, 607
mapping data to, 608-609
missing data, 620
scaling, 610
showing details, 618-620
stacked column charts, 617
Win/Loss charts, 607, 613, 616

spearing formulas, 1��
specific da\s of the weeN, highlighting data from, ���
specif\ing custom �' Maps, �������
spillable formulas, macros, ���
Spilled Range Operator ���, 112, �1�
spilling formulas, 11��111
splitting

delimiters in new rows, 330-331
text, 195

LEFT function, 196
MID function, 197
RIGHT function, 196
TEXTSPLIT function, 207

S4RT function, 1�2�1��
S4RT3, function, 1�2
sTuare roots, calculating with S4RT function, 1�2�1��
stacNed column charts, sparNlines, �1�
stacNing parentheses � � � �, 11��11�
stamps, date�time, ��
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Table tool (Ctrl+T) ���

statistics
Analysis ToolPak, 769-771
functions, 719-729
workbooks, viewing, 495

status bar, adding numbers, �����
sticNers, �2�, �������
stocN data, ���, 2��
STO&.+,STORY function, 2�1
StocN ,mages, inserting into Excel, �������
store maps, �' Maps, ���
storing

formula results with LET function, 260-264
hyperlinks, 58
logic with LAMBDA function, 264-265
workbooks, 674

st\les
chart styles, 574-575, 584-585
formatting cells, 525-527
pictures

Artistic Effects, 642
Picture Styles gallery, 640-642

shapes, choosing, 632
SmartArt, 624-627

subscripts, formatting, 2�
subsets

cells, showing data bars, 548
columns, selecting subsets with FILTER function, 307

SU%ST,TUTE function
generating text characters, 192
replacing text characters, 202

subtotals
automatic subtotals, adding, 339-341
collapsed subtotal view, sorting with largest customers at 

top, 342-343
daily dates by month, 348
multiple fields, 347
one-page summaries, showing subtotals, 342
removing, 346
rows

copying only rows, 344-345
formatting, 345-346

SUBTOTAL function
multiple levels of totals, 155
totaling visible cells, 156

subtraction operations, order in formulas, 11�
SUM function, 1���1�2, 1���1��. See also AutoSum
SUM,)S function, �, 1���1��
summari]ing data

daily dates, pivot tables, 381-382
date filters, 357-359
filtering, 349-350

adding values, 366-367
advanced filter, 360-367
clearing filters, 353
columns with applied filters, 352
combining duplicates, 366-367
combining filters, 352
copying filtered results, 360
formatting filtered results, 360
Filter by Color, 356-357
Filter by Selection, 353-356
number filters, 358-359
reapplying filters, 353
refreshing filters, 353
removing duplicates from filtered results, 364-365
resizing drop-down menu, 353
selecting multiple items, 351-352
totaling filtered results, 360

one-page summaries, showing with subtotals, 342
subtotals

automatic subtotals, 339-341
copying only subtotal rows, 344-345
daily dates by month, 348
formatting rows, 345-346
multiple fields, 347
removing, 346
showing in one-page summaries, 342
sorting collapsed subtotal view with largest customers at 

top, 342-343
text filters, 358-359

summing records, 'SUM function, 2���2��
superscripts, formatting, 2�
S:,T&+ function, 21��21�
switching

between views, 39
task panes, 23

s\mbols, inserting into cells, ���

T
T function, 2��
tables

data tables, what-if analyses, 433-434
joining, Power Pivot (Data Model), 410-411
ranges, defining as tables, 108
relationships, creating with Power Pivot (Data Model), 

411-412
what-if-tables

modeling random scenarios using data tables, 433-434
two-variable what-if tables, 431-432

Table tool �&trl�T�, cop\ing formulas, 1���1��
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�1� tabs

tabs, ribbon
contextual tabs, 25
Developer tab, 24
scrolling through, 22

tall cells, smooth scrolling, �
tasN panes, 22

collapsible task panes, 10, 23
multiple task panes, opening at once, 11
switching, 23

telephone numbers, displa\ing, ���
templates, saving chart st\les as, �������
testing

arguments, 275
functions, Fast Excel, 774-775
records in loops, 473-474
text case, EXACT function, 204
value types, IS functions, 220

text
bold text, 516-517
case-sensitive text

converting, 188-189
sorting data, 44
testing with EXACT function, 204

cell notes, 535-538
characters

finding number of in text cells, LEN function, 198
generating, 192-195
locating in text cells, 198-202
replacing with SUBSTITUTE function, 202
viewing character codes, 195

CHOOSECOLS function, 208
CHOOSEROWS function, 208
columns, 208
containing values, conditional formatting, 561-562
converting numbers to text with VALUE function, 207
customizing

bold text, 516-517
font size, 515
font typeface, 515
italic text, 516-517
numeric formatting, 511
rotating text, 523-524
underline text, 516-517
vertical text, 523-524

definitions, viewing with Insights (Smart Lookup), 495-496
filters, 358-359
flowing into ranges, 633-634
fonts

changing default fonts, 532-533
changing size, 515

changing typeface, 515
themes, 530

formatting
individual characters, 531-532
numbers as text with TEXT function, 204-205
numbers with leading zeroes, BASE function, 206-207
returning to original text with T function, 207
text containing values, 561-562
with mini toolbar, 36

HSTACK function, 207
individual characters, formatting, 531-532
international text comparisons, 4
italic text, 516-517
joining

ampersand operator (&), 121
dates/time, 121-122
TEXTJOIN function, 121, 187-188
with numbers, 121-122

justifying in ranges, 534-535
leading/trailing spaces, removing, 189-193
long text passages, flowing into ranges, 633-634
lowercase text, sorting data, 44
repeating with REPT function, 202-204
rotating, 523-524
rows, 208
separating with delimiters, 489-490
splitting, 195

LEFT function, 196
MID function, 197
RIGHT function, 196
TEXTSPLIT function, 207

TEXTAFTER function, 207
TEXTBEFORE function, 207
Text That Contains formatting rule, 561-562
TOCOL function, 208
TOROW function, 208
underline text, 516-517
uppercase text, sorting data, 44
VECTORWRAP function, 208
vertical text, 523-524
VLOOKUP function, 218, 225-227, 260
VSTACK function, 207
WordArt, 623, 632-633
wrapping in cells, 533-534

text boxes, �2�, �������
text dates, converting to real dates, 1���1��
text functions

BASE function, 206-207
CHAR function, 192-195
CHOOSECOLS function, 208
CHOOSEROWS function, 208
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toolbars �11

CODE function, 195
EXACT function, 204
FIND function, 198-201
HSTACK function, 207
LEFT function, 196
LEN function, 191, 198
LOWER function, 188-189
MID function, 197
PROPER function, 189
REPT function, 202-204
RIGHT function, 196
SEARCH function, 200-202
SUBSTITUTE function, 192, 202
T function, 207
TEXT function, 204-205, 704-705
TEXTAFTER function, 207
TEXTBEFORE function, 207
TEXTJOIN function, 187-188
TEXTSPLIT function, 207
TOCOL function, 208
TOROW function, 208
TRIM function, 189-193
UNICHAR function, 192-195
UNICODE function, 195
UPPER function, 188-189
VALUE function, 207
VECTORWRAP function, 208
VLOOKUP function, 190, 218, 225-227, 260
VSTACK function, 207

TE;TJO,N function, 121
text times, converting to real times, 1���1��
themes, �2�

changing, 528
choosing, 528
color, 529
components of, 528
creating

color, 529
fonts, 530
reusing effects, 530

effects, reusing, 530
fonts, 530
Office themes, 527-529
saving, 530
sharing, 531
using on new documents, 531

thousands separators, numeric formatting, ���
threaded comments, sharing worNbooNs, �������
three da\s of toda\, finding cells, ���

time�dates, 1���1��
3D Map time choices, 601
custom numeric formatting, 512-513
date and time functions, 709-711
DATE function, 173-175
DATEDIF function, 180-182
DATEVALUE function, 176-177
DAX measures, 421-423
DAY function, 173
DAYS function, 183
displaying, 507
elapsed time, calculating, 180-183
EOMONTH function, 183
formatting, 168-170
grouping

dates into weeks, 179-180
days of the week, 178-179

HOUR function, 173
ISOWEEKNUM function, 179
joining text with, 121-122
load times, 3
MINUTE function, 173
MONTH function, 173
NETWORKDAYS function, 184-186
NOW function, 171-172
potential problems, 166-167
SECOND function, 173
TIME function, 175
timestamps, 78
TIMEVALUE function, 177-178
TODAY function, 171-172
troubleshooting, 166-167
WEEKDAY function, 178-179
WEEKNUM function, 180
WORKDAY function, 183-185
workdays, calculating, 183-186
YEAR function, 173
YEARFRAC function, 180

tipping �' Maps, ���
title bar, searching from, ��
titles, :ordArt, ��2����
TO&OL function, 2��
TO'AY function, 1�1�1�2
toolbars

mini toolbar, formatting selected text, 36
QAT, 14

adding icons, 27
customizing, 28-29
KeyTips, 63-64
removing icons, 28
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�12 toolbars

resequencing icons, 29
separating icons, 29

status bar, adding numbers, 38-39
ToolTips, 1��
Top 1� )ilter dialog box, pivot tables, �������
top�bottom rules, conditional formatting, �������
TORO: function, 2��
totals

filtered results, 360
numbers with SUBTOTAL function

multiple levels of totals, 155
visible cells, 156

pivot tables
including filtered items in totals, 416-418
percentages of totals, 385-386

Touch mode, adding whitespace to icons, ��
tours, �' Maps, ���
Trace Error, 12�
tracing dependents, 12�
tracNing changes

Catch Up button, 692
Show Changes, 690
Version History, 690-693

traditional formatting, ��1����
trailing spaces�leading �text�, removing, 1���1��
transforming data with 3ower 4uer\, �2���2�
transparent images, 1��1�, ���
TRANS3OSE function, 2��
triangles �right�, h\potenuse of, 2���2��
trig functions, �1���1�
TR,M function, 1���1��
troubleshooting

AutoSum errors, macros, 466
contextual ribbon tabs, 25
dates/time, 166-167
Flash Fill, 41-42
formulas

evaluating in slow motion, 129
evaluating parts of formulas, 130
Formula Auditing arrows, 127-128
highlighting cells, 126
seeing all formulas, 126
showing direct precedents, 126-127
tracing dependents, 128
Watch Window, 129

macros, 466, 477
pivot tables, 25, 380
PMT function, 430
Power Query M functions, 760
sorting data, 46-47
time/dates, 166-167

Trust &enter, LinNs tab, 2�2�2��
turning data with TRANS3OSE function, 2��
turning on�off &S9 file reminders, �����
twisted ;LOO.U3, 2��
two�monitor setups, ��
two�variable what�if tables, ��1���2
two�wa\ looNups, ;LOO.U3 function, 2���2�1
t\peface �font�, changing, �1�
T\peScript, ���

U
U') �user�defined function�, ���
unar\ minus, order of operations, 11�
underline text, �1���1�
unhiding multiple worNsheets, �
UN,&+AR function, 1�2�1��
UN,&O'E function, 1��
UN,4UE function, �����1�
uniTue records, advanced filters, ������1
uniTue seTuences, sorting data, ��
uniTue values

extracting with formulas, 308-310
identifying with conditional formatting, 560-561

unit values, 'ATE',) function, 1�1
unpivoting data with 3ower 4uer\, �2���2�
unsaved worNbooNs

linking to, 291
recovering, 32

unselecting cells, �����
unsupported formulas, ��
Update LinNs dialog box, preventing from appearing, 

2���2��
updating

links, 293-294
ribbon, 21

upgrading from Excel 2�1�, 1��1�
uppercase text, sorting data, ��
U33ER function, 1���1��
user access, collaboration, �������

V
valid names, 2���2��
9ALUE function, 2��
values

adding, 366-367
axis values, sparklines, 614-615
converting formulas to values with right-drag menu, 289
duplicate values, identifying with conditional formatting, 

560-561
error values, replacing when printing, 670
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formulas versus, 94
testing with IS functions, 220
text containing values, conditional formatting, 561-562
unique values

extracting with formulas, 308-310
identifying with conditional formatting, 560, 561

variable number of rows, handling with &trl�'own�Arrow 
Ne\, ���

variables, �������
9%A �9isual %asic for Applications�, ���

add-ins, 765
coding analogy, 458

collections, 459
examining recorded code, 463
object.method, 459
parameters, 460-462
properties, 462

collections, 459
Help, 462
macros, 5

advanced filters for unique records, 479-481
AutoFilter, 481-482
AutoSum errors, 466
customer reports, 477-484
customizing, 467-468
debugging, 476
deleting records from loops, 474-476
editing, 457
everyday-use macros, 467-468
finding last rows with data, 468-469
flow control, 471-473
GetOpenFileName, 467-468
GetSaveAsFileName, 467-468
If-End If constructs, 471-472
invoice register example, 454-456
looping through rows, 469
loops with FinalRow, 471
macro recorder, default state, 449-450
macro recorder, parameters, 461-462
macro recorder, starting, 451-452
mail merges, 447-449
R1C1-style formulas, 464-465
range references, 470
recording, 446-452
recording, in blank workbooks, 455-456
recording, Relative References, 450
running, 453-454
running at full speed, 477
running in slow motion, 476
Select Case constructs, 472-473
selecting visible cells, 482-483

spillable formulas, 466
testing records in loops, 473-474
troubleshooting, 477
variables, 463-464

object.method, 459
parameters, 460-462
properties, 462
R1C1-style formulas, 464-465
ribbon, 24
security, 446
spillable formulas, 466
variables, 463-464

9%A Editor, �
9%E �9isual %asic Editor�, ���
9E&TOR:RA3 function, 2��
verbs, obMect.method as, ���
9ersion +istor\, �������
vertical text, �2���2�
vetoes, editing worNbooNs, ��1���2
viewing

access to workbooks, 677-678
all formulas, 126
all options in Find dialog box, 8
Backstage view, File menu, 30-32
cells

bringing active cells back into view, 489
Watch Window, 129

dark mode, 56
definitions (text) with Insights (Smart Lookup), 495-496
direct precedents, 126-127
Normal view, 39
Page Break preview, 39
Page Layout view, 39
pivot tables

changes, 380
data, 369

sparkline details, 618-620
subtotals, one-page summaries, 342
switching between views, 39
workbook statistics, 495
worksheets, side by side, 284-285

visible cells
selecting with macros, 482-483
totaling with SUBTOTAL function, 156

9isio 'ata 9isuali]er, ��2
visuali]ations, data

color scales, highlighting extremes, 549-550
data bars

creating, 545-546
customizing, 546-547
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�1� visualizations

in-cell bar charts, 544-545
showing for subsets of cells, 548

heat maps, 543
icon sets

hiding icons, 554
mixing icons, 554
moving numbers closer to icons, 552-553
segregating data, 550-551
setting up, 551-552

9LOO.U3 function, 1��, 21�, 22��22�, 2��
9STA&. function, 2��

W
:atch :indow, 12�, �������
watching results of distant cells, �������
waterfall charts, financial data, ���
watermarNs, adding to headers, �������
web functions, ���
:EE.'AY function, ���
:EE.NUM function, 1��
weeNs, grouping dates b\

day of the week, WEEKDAY function, 178-179
ISOWEEKNUM function , 179
WEEKNUM function , 180

what�if anal\ses
modeling random scenarios using data tables, 433-434
two-variable what-if tables, 431-432
using, 429-430

whitespace, adding to icons, ��
wide cells, smooth scrolling, �
widths �columns�, formatting, �1���2�
wildcards, Label )ilter Á\�out, ���
:indows 11, Arrange All, 1�
:in�Loss charts, sparNlines, ���, �1�, �1�
:ordArt, �2�, ��2����
worNbooNs

access, viewing, 677-678
auditing, Inquire add-in, 768-769
AutoSave, 694
closed workbooks, opening with links, 293
collaboration

#Mentions, 677, 687, 692
cloud storage, 674
comments, 677, 687, 692
editing, etiquette, 681
editing, multiple editors with same workbook, 680
editing, presence, 680-681
editing, vetoes, 681-682
filtering data, Sheet Views, 683-686
finding shared notebooks, 679-680

Notes, 689
OneDrive, 674
sharing during initial saves, 675
sharing notifications, 678-680
sharing, setting expiration dates, 676-677
sharing with Share button, 676
sorting data, Sheet Views, 683-686
threaded comments, 688-689
tracking changes, Catch Up button, 692
tracking changes, Show Changes, 690
tracking changes, Version History, 690-693
user access, 677-678

copying worksheets to new workbooks, 541
editing, 33

etiquette, 681
multiple editors, same workbook, 680
presence, 680-681
vetoes, 681-682

filtering data, Sheet Views, 683-686
finalizing, 33
getting information, 33
LAMBDA function, sharing between workbooks, 267-268
links

creating to unsaved workbooks, 291
creating with formulas, 291
creating with mouse, 289-290
creating with Paste Options menu, 286-287
creating with right-drag menu, 287-289
external workbook links, absolute references, 290
Links tab, Trust Center, 292-293
missing linked workbooks, 293
opening closed workbooks, 293
Update Link dialog box, preventing from appearing, 

294-295
updating, 293-294

macros, recording in blank workbooks, 455-456
merging, 438
names, 256-257
opening

searching while opening, 8
UDF, 4

Power Query, loading data from single workbook, 323-324
previous versions, Version History, 692-693
Recent Workbooks list, clearing, 32
recovering, 32
rolling back changes, Version History, 692-693
saving

AutoSave, 694
sharing during initial saves, 675

searching while opening, 8
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sharing
comments, 677, 687, 692
during initial saves, 675
expiration dates, 676-677
finding shared workbooks, 679-680
#Mentions, 677, 687, 692
Notes, 689
notifications, 678-679
threaded comments, 688-689
tracking changes, Catch Up button, 692
tracking changes, Show Changes, 690
tracking changes, Version History, 690-693
with Share button, 676
workbooks, 680

Sheet Views, filtering/sorting data, 683-686
statistics, viewing, 495
storing, 674
UDF, 4
unsaved workbooks

linking to, 291
recovering, 32

worNda\s, calculating
NETWORKDAYS function, 184-186
WORKDAY function, 183-185

worNÁows, establishing with 3ower 4uer\, �22
worNing remotel\. See collaboration
worNsheets

3D Models, 624, 648-649
adding, 35
appending

one worksheet from every workbook in folder, 331-332
one worksheet from one workbook, 332-333
Power Query, 331-333

auditing with Inquire, 491
controls, 35
copying to new workbooks, 541
Cut-out People, 624, 647-648
documenting with FORMULATEXT function, 232-234
excluding parts of worksheets from printing, 659
formatting

aligning cells, 514
bold text, 516-517
borders, 517
cell color, 517-519
cell notes, 535-538
Cell Styles, 525-527
centering cells, 520-523
changing default fonts, 532-533
column widths, 519-520
conditional formatting, 539
copying formatting to new worksheets, 540-541

copying formulas, 538
font size, 515
font typeface, 515
Format Painter, 539-540
italic text, 516-517
justifying text in ranges, 534-535
merging cells, 520-523
need for, 499-501
numeric formatting, built-in, 505
numeric formatting, currency, 506
numeric formatting, custom formats, 509-513
numeric formatting, dates, 507
numeric formatting, Format Cells dialog box, 505
numeric formatting, fractions, 507
numeric formatting, Home tab, 503-505
numeric formatting, phone numbers, 508
numeric formatting, Social Security numbers, 509
numeric formatting, thousands separators, 506
numeric formatting, times, 507
numeric formatting, ZIP Codes, 508-509
pasting formulas, 538-539
rotating text, 523-524
row heights, 519-520
text, individual characters, 531-532
themes, 527-530
traditional formatting, 501-503
underline text, 516-517
vertical text, 523-524
wrapping text, 533-534

headers/footers
adding pictures/watermarks, 663-664
automatic headers, 662
custom headers, 663
different headers/footers in same document, 664-665
scaling, 665

headings, repeating on each page, 658
icons, 624, 647-648
illustrations, 624, 647-648
links

creating with formulas, 291
creating with mouse, 289-290
creating with Paste Options menu, 286-287
creating with right-drag menu, 287-289
Links tab, Trust Center, 292-293

margins, 657
moving between, 77
multiple worksheets, unhiding, 3
names, returning with CELL function, 223
navigating, 35
Online Pictures, 624, 636-637
orientation, 657
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�1� worksheets

page breaks, 660-661
pictures, 624

arranging, 645-647
Artistic Effects, 642
Aspect Ratio, 638
brightness, 639-640
contrast, 639-640
cropping, 639
file sizes, 644
formatting with ribbon tab, 637
inserting Bing Images, 637
inserting Clip Art, 636-637
inserting from your computer, 635
inserting into Excel, 635
inserting multiple pictures at once, 635
inserting Stock Images, 636-637
Picture Styles gallery, 640-642
removing backgrounds, 642-643
resizing, 637
rounded corners, 639
Screen Clippings, 645
selecting, 645-647
sharpness, 639-640
transparency, 640

printing
as PDF, 671
centering worksheets on page, 669-670
changing Page Setup settings, 668
changing printer properties, 668
choosing printers, 666
choosing what to print, 667
comments, 670
controlling first page numbers, 670
gridlines, 669
page numbers, 656
paper size, 657
previewing, 654-656
Print panel, File menu, 666
replacing error values, 670

protecting, 488-489
scaling data to fit pages, 660
shapes, 623

choosing styles, 632
displaying cell contents, 630-632

side by side, viewing, 284-285

SmartArt, 623
adding images, 628
changing existing SmartArt to new styles, 627
common elements, 625
Hierarchical SmartArt, 629-630
inserting, 626-627
organizational charts, 629-630
styles, 624-625

stickers, 624, 647-648
text boxes, 623, 633-634
unhiding multiple worksheets, 3
WordArt, 623, 632-633
zooming in/out, 37-38

world maps, ���
wrapping text in cells, �������
writing data with Action 3en, 1��1�

X
;LOO.U3 function, 22��22�

matching lists, 230
returning

cell references, 232
multiple values, 228-229

sideways searches, 229-230
twisted XLOOKUP, 230
two-way lookups, 230-231

;MAT&+ function, matching lists, 2��
; Y Scatter charts, ��1����

Y
YEAR)RA& function, 1��
YEAR function, 1��
\ears, pivot table summaries, ��1���2

Z
=A button, sorting data, ��
]eroes �leading�, adding to numbers with %ASE function, 

2���2��
=,3 &odes, �������
]ooming in�out

3D Maps, 589-594, 598
worksheets, 37-38
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